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Preface
Welcome to the Genesys Agent Scripting 8.1 Deployment Guide. This guide 
describes system requirements, installation of the Genesys Agent Scripting 
application, installation of supporting applications, and Genesys Agent  
Scripting Collaboration mode.

This document is valid for the 8.1 release(s) of this product. 

This preface contains the following sections:
 About Genesys Agent Scripting, page 9
 Intended Audience, page 10
 Making Comments on This Document, page 10
 Contacting Genesys Technical Support, page 10
 Document Change History, page 11

For information about related resources and about the conventions that are 
used in this document, see the supplementary material starting on page 105.

About Genesys Agent Scripting
Genesys Agent Scripting is a customization solution available with Genesys 
Inbound Voice and Genesys Outbound Voice, a development tool that enables 
you to create and maintain browser-based web applications called “business 
process scripts.” A business process script guides agents through an effective 
customer interaction flow and helps them complete a structured business 
process. 

The Genesys Agent Scripting web application provides many benefits. It 
ensures the quality of the interaction, adds structure and clarity to the 
definition of the process, integrates data access and data entry capabilities, 
maximizes the probability of success, and minimizes the training required by 

Note: For versions of this document created for other releases of this 
product, visit the Genesys Documentation website, or request the 
Documentation Library DVD, which you can order by e-mail from 
Genesys Order Management at orderman@genesys.com.

mailto:orderman@genesys.com
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the agent. Genesys Agent Scripting assists in constructing the interfaces to 
other back office systems.

Intended Audience
This guide is primarily intended for system administrators or Genesys Agent 
Scripting web application developers. It is also intended for contact center 
agents who will install and use Genesys Agent Scripting. The guide assumes 
that you have a basic understanding of:

• CTI concepts, processes, terminology, and applications.

• Network design and operation.

• Your own network configurations.

• You should also be familiar with:
 Scripting using Active Server Pages (ASPs) or Java Server Pages 

(JSPs).
 Apache Tomcat 5.0 or 6.0; or Microsoft IIS 6.0, 7.0 or 7.5 web servers.
 HTML editing.

Making Comments on This Document
If you especially like or dislike anything about this document, feel free to 
e-mail your comments to Techpubs.webadmin@genesys.com. 

You can comment on what you regard as specific errors or omissions, and on 
the accuracy, organization, subject matter, or completeness of this document. 
Please limit your comments to the scope of this document only and to the way 
in which the information is presented. Contact your Genesys Account 
Representative or Genesys Technical Support if you have suggestions about 
the product itself.

When you send us comments, you grant Genesys a nonexclusive right to use or 
distribute your comments in any way it believes appropriate, without incurring 
any obligation to you.

Contacting Genesys Technical Support
If you have purchased support directly from Genesys, please contact Genesys 
Customer Care.

Before contacting technical support, please refer to the Genesys Customer 
Care Program Guide.

http://genesys.com/customer-care
http://genesys.com/customer-care
mailto:techpubs.webadmin@genesys.com
http://docs.genesys.com/Special:Repository/8genesys-care.pdf?id=405c9e42-2731-4288-8818-f3a40b12d807
http://docs.genesys.com/Special:Repository/8genesys-care.pdf?id=405c9e42-2731-4288-8818-f3a40b12d807
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Document Change History
This section lists topics that are new or that have changed significantly since 
the first release of this document.

Changes to GAS 8.1.2

• Added Chapter 7, “Load Balancing and Failover,” on page 89.

Changes to GAS 8.1.1

• “Agent Scripts” were renamed “Business Process Scripts” and the “Editor” 
was renamed the “Genesys Agent Scripting development environment” 
throughout the documentation.

• Added 4 bullet points to explain Figure 1, “Structure of typical Genesys 
Agent Scripting setup,”  on page 14.

• Updated and revised the section “Requirements and Supported Software” 
on page 19 in Chapter 2.

• Added the section “Database Drivers” on page 31 in Chapter 4.

• Added the procedure “Enable the Role Privilege” on page 45 in Chapter 5.

Changes to GAS 8.1.0

• Product was updated from version 7.2 to 8.1.0; a process that involved 
screen shot and textual changes throughout.

• Chapter 2, System Requirements
 Numerous changes to software both supported and required, as 

third-party versions were upgraded.

• Chapter 5, Installing Genesys Agent Scripting for Use with Genesys Agent 
Interaction Layer
 Added the new section “Agent Desktop Integration with Genesys 

Agent Scripting” on page 41, which includes these procedures:
 “Integrate Genesys Agent Desktop (v7.6 or higher) with Genesys 

Agent Scripting using Genesys Agent Interaction Layer” on 
page 42.

 “Installing the Interaction Workspace Plug-in for Genesys Agent 
Scripting” on page 44.

 “Deploying Assignment Rules to Interaction Workspace” on 
page 46.

 “Installing the Interaction Workspace plug-in for Genesys Agent 
Scripting, Simple Install Method” on page 46.

 “Installing the Interaction Workspace plug-in for Genesys Agent 
Scripting, Click-Once Method” on page 47.
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 “Localizing the Interaction Workspace plug-in for Genesys Agent 
Scripting” on page 48.
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Chapter

1 Overview of Genesys Agent 
Scripting
Genesys Agent Scripting is a development tool that enables you to create and 
maintain browser-based web applications called “Business process scripts.” 
This chapter contains the following sections:
 What are Business Process Scripts?, page 13
 Genesys Agent Scripting Architecture, page 14
 Genesys Agent Scripting Components, page 15
 New in This Release, page 16

What are Business Process Scripts?
An Business process script guides contact center agents through an interaction 
with a contact and helps them complete a structured business process. Typical 
business processes include filling out an application, identifying the right type 
of expert contact to handle an inquiry, troubleshooting a system, and so on.

The Business process script enables a contact center agent to work with the 
contact to complete a task. The script provides text (such as well-pointed 
questions) and data that help the agent deliver a consistently high level of 
service to the contact. 

In addition to providing a simple linear flow of script text and related controls, 
a Genesys agent script can react dynamically to information from a customer. 
This means that, using Genesys Agent Scripting, you can design a script to 
handle normal variations in a structured business process. As necessary, the 
script can respond dynamically to the answers to scripted questions. 
Depending on the feedback, the flow of the script may change from one course 
to another. If the default flow is not correct for the contact's circumstances, the 
script may adjust by displaying a different page of text to the agent. 
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Business process scripts provide many benefits. A script ensures the quality of 
the interaction, adds structure and clarity to the definition of the process, 
integrates data access and data entry capabilities, maximizes the probability of 
success, and minimizes the training required by the agent. Genesys Agent 
Scripting assists in constructing the interfaces to other back office systems.

Genesys Agent Scripting Architecture

Figure 1: Structure of typical Genesys Agent Scripting setup

Figure 1 illustrates the typical structure of a Genesys Agent Scripting 
installation.

• Business Process Scripts (Genesys Agent Scripting web applications) are 
created in Genesys Agent Scripting development environment and then 
deployed to a web server such as Apache Tomcat, Microsoft IS, or IBM 
Application WebSphere.

• Genesys Agent Scripting web applications are accessible to the Agent 
Desktops via a web browser for stand-alone applications, or they can be 
integrated into Genesys Agent Desktop or Interaction Workspace. 

• Business Process Scripts can benefit from the integration of Genesys 
Servers; they also open interfaces with other services to create custom 
solutions. 

• Genesys Collaboration Server can be used to secure development process 
by multiple users and development groups.

Genesys Agent Scripting
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For details on supported environment software, see “Requirements and 
Supported Software” on page 19.

Genesys Agent Scripting Components
This section describes the components that make up the Genesys Agent 
Scripting application. 

The Genesys Agent Scripting Development Environment

The Genesys Agent Scripting Development Environment is a Windows-based, 
call-flow designer that developers use to write and edit complex business 
process scripts.

It provides two design modes:

• Graphical requires the installation of Microsoft Visio (2003, 2007, or 
2010) software. This design mode employs customized flowchart elements 
to create, edit, or display the individual components of a call flow.

• Tree-Structured is the default design mode if you do not install Microsoft 
Visio 2003 Professional. This design mode employs a standard tree 
structure to create, edit, or display pages, streams, process flows, and 
projects.

Genesys Agent Scripting contains a compiler that developers use to compile 
their newly created business process scripts and generate source files. The 
source files are one of the following types:

• Active Server Page (ASP) or ASP.NET (ASPX) based on .Net Framework 
1.1 & 2.0 that run on a Microsoft IIS 5.0, 6.0, 7.0 & 7.5 server.

• Java Server Page (JSP) source files that run on an Apache Tomcat 5.0 or 
6.0 server, or on the IBM WebSphere Application Server, version 5.1 or 
6.0.

The Genesys Agent Scripting Development Environment provides two 
code-generation modes:

• Incremental (generates only what has changed since the last compile)

• Full (compiles all elements)

Developers can use the Simulate action in the Genesys Agent Scripting 
Development Environment to start an Internet Explorer browser, and test 
scripts before actual deployment. 

The Runtime Engine

The runtime engine provides agents access to the developed business process 
scripts, which reside on a web server and which the agent accesses and uses 
through a web browser.
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The agent carries out an interaction with a customer. The runtime engine 
provides:

• An intuitive display within the web browser.

• Automatic and transparent business process script updates.

• Data-entry validation.

• Navigation capabilities for the agent.

These features facilitate the agent’s use of the designed business process script 
and guide the agent to a smooth interaction with the customer.

Collaboration Mode

Collaboration mode allows you to: convert Project Books to a multi-user 
format; check in and check out files; lock and unlock Project Books; and 
access the administration function to manage users and servers (for system 
administrators only). 

The following functions are available in Collaboration mode:

• Conversion of Project Books for multiple users

• A Collaboration Check In / Check Out feature to manage multiple-user 
Project Books

• Login with password protection for system-administrator access to 
Collaboration Administration

• The ability to add, delete, activate, or deactivate user accounts and to 
update user information

• The ability to lock and unlock multiple-user Project Books and to change 
the Lock mode

In many cases, it may be necessary for several developers to combine their 
efforts, or collaborate, on a large design/development project. After 
conversion to Collaboration mode, the Project Book remains in this mode. It 
cannot be restored to a single user mode.

New in This Release
Release 8.1.2 This section describes the new features in Genesys Agent Scripting release 

8.1.2:

• Support for Load Balancing.

• Support for Failover.

Release 8.1.1 8.1.1 is a Maintenance Release of Genesys Agent Scripting that improves 
existing software functionality and documentation, including:

• Support for the Role privilege.

• Support for Microsoft Visio 2007 and 2010.
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• Branding to reflect Genesys’s 2012 status as an independent company.

Release 8.1.0 This section describes the new features in Genesys Agent Scripting release 
8.1.0.

• Genesys Agent Scripting now integrates with Interaction Workspace, using 
the Interaction Workspace Plug-in for Genesys Agent Scripting.

• Genesys Agent Scripting has a compliant look and feel with the Genesys 
8.x software suite.

• You can deploy for Interaction Workspace or Genesys Agent Desktop, on 
the Deployment Settings Tab of the Process Flow Assignment Rules dialog 
box. Press F1 to view the corresponding help topic, for details.

• When a business process script that supports the Mark Done feature is 
running under Interaction Workspace, the Mark Done button is hidden in 
the Interaction Window of Interaction Workspace.

• Opening a GAS 7.2 script with the 8.1 Genesys Agent Scripting 
Development Environment automatically migrates it to Genesys Agent 
Scripting 8.1.

• The new default Stylesheet for business process scripts that you create in 
Genesys Agent Scripting 8.1 can also be applied to imported business 
process scripts.
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Chapter

2 System Requirements
This chapter outlines the software requirements for the Genesys Agent 
Scripting 8.1 application.

This chapter contains the following sections:
 Requirements and Supported Software, page 19
 Migration of Database Interfaces that Use Stored Procedures, page 22

Requirements and Supported Software
Review the operating system and software requirements for running the 
Genesys Agent Scripting in this section before installing Genesys Agent 
Scripting.

Requirements Overview

This section describes deployment types and options of Genesys Agent 
Scripting. 

Business Process Scripts visualization

The Genesys Agent Scripting development environment supports graphical 
visualization of Process Flows and Stream Flows of Business Process Scripts. 
To use this feature, you must install Microsoft Visio on the same machine as 
Genesys Agent Scripting.

Standalone Application

To deploy and run any standalone Genesys Agent Scripting web application 
developed in the Genesys Agent Scripting development environment requires:
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• Genesys Agent Scripting Server

• A web browser

Integration with Genesys Environment

Genesys Agent Scripting web application integration with Genesys 
environment requires integration layer to communicate with Genesys servers.

• The Genesys Agent Scripting web application requires Genesys Agent 
Scripting Server and a web browser.

• Genesys environment integration in your project requires the Genesys 
Agent Interaction Toolkit enables.

• The Java-based server platform requires additional libraries, which are 
included in Genesys Agent Scripting. 

• For the Microsoft IIS platform, use Genesys Integration Server and Agent 
Interaction 

Agent Desktop customization for Genesys environment integration is available 
for Genesys Agent Desktop and Interaction Workspace. Genesys Agent 
Desktop is customized with a customization servlet included with Genesys 
Agent Scripting. Interaction Workspace is customized by the Interaction 
Workspace Plug-in For Genesys Agent Scripting. As with most Genesys 
products, Genesys Agent Scripting web application requires Application 
configuration on Genesys Configuration Server. To complete integration of 
your Business Process Scripts, you must set Assignment Rules for your Agent 
Desktop.

Genesys Collaboration Server

Collaboration Mode supports multiple users and development groups on the 
Genesys Agent Scripting development environment. This feature requires 
Genesys Collaboration Server and database server. 

Load Balancing and Failover

The load balancing and failover feature requires Apache HTTP server 2.x with 
the mod_proxy or the mod_jk modules configured.

Note: Genesys Environment integration based on Microsoft IIS is 
supported only for the ASPX platform.

Note: Load balancing and failover is supported for Tomcat deployment only.
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Supported Software

Genesys Agent Scripting Development Environment OS Support

• Windows x86 (32-bit): 2003, 2008, Vista, Windows 7, 8, 8.1

• Windows x64 (32-bit): 2003, 2008, 2012, Vista, Windows 7, 8, 8.1

Graphical Design Software

• Microsoft Visio 2003, 2007 and 2010. Visio is required only for graphical 
design mode, showing Process and Stream Flow diagrams within the 
Genesys Agent Scripting Development Environment.

Version Control Server Databases Support

• 10g Release 1, 10g Release 2, 11g, 11g RAC.

• Microsoft SQL Server 2005, 2008.

• MySQL 4 or higher

• DB2 8.1, 8.2

Genesys Agent Scripting Server OS Support

• Red Hat Enterprise Linux (32 & 64-bit): 4.0, 5.0, 6.0, 7.0

• Windows x86 (32-bit): 2003, 2008, Vista, Windows 7, 8, 8.1

• Windows x64 (32-bit): 2003, 2008, 2012, Vista, Windows 7, 8, 8.1

• Windows x64 (64-bit): 2003, 2008, 2012, Windows 7, 8, 8.1

Genesys Agent Scripting Web Server Support

• Tomcat 5.0, 6.0, 7.0

• IIS 6.0, 7.0, 7.5, 8.0, 8.5

• IBM WebSphere Application Server 5.1, 6.0

• Apache HTTP 2.x

Genesys Agent Scripting Server Databases Support

• 10g Release 1, 10g Release 2, 11g, 11g RAC.

• Microsoft SQL Server 2005, 2008

• DB2 8.1, 8.2

Java SDK Frameworks Support

• Java SDK 1.4.2, 1.5, 1.6 
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Genesys Agent Scripting Client Browsers Support

• Microsoft Internet Explorer 6, 7, 8, 9, 10, 11

• Citrix, XenApp 4.0, 4.5, 5.0, 6.0

Genesys Agent Desktop Client OS Support

• Windows x86: Vista, Windows 7, 8, 8.1

• Windows x64: Vista, Windows 7, 8, 8.1

Interaction Workspace Plug-in for Genesys Agent Scripting OS Support

• Windows x86 (32-bit): 2003, 2008, Vista, Windows 7, 8, 8.1

• Windows x64 (32-bit): 2003, 2008, 2012, Vista, Windows 7, 8, 8.1

Migration of Database Interfaces that Use 
Stored Procedures

After migrating a project book to the new version of Genesys Agent Scripting, 
some special considerations exist.

If the project book contains the Database Interface for Stored Procedures, you 
will need to perform some manual changes, using the Genesys Agent Scripting 
Development Environment. This section explains how to make these changes.

Genesys Agent Scripting 7.2 and higher supports output parameters and return 
values for Stored Procedures. 

Defining Specific Parameters 

To support this feature, you must define the Stored Procedures parameters that 
have the following directions and SQL Types.

Directions:
 Input 
 Output 
 Input/Output
 Return Value

Note: The information in this section applies only to Project Books 
containing Database Interfaces that use Stored Procedures from 
Releases 7.0 and 7.0.1. It also assumes that you are upgrading to 7.2 
or higher.



Deployment Guide 23

Chapter 2: System Requirements Migration of Database Interfaces that Use Stored Procedures

SQL Types: 
 INTEGER 
 FLOAT 
 VARCHAR
 DATE
 TIMESTAMP
 CURSOR 
 REAL
 SMALLINT
 BIGINT
 DOUBLE
 DECIMAL
 TIME

For existing project books that contain Stored Procedures parameters, Genesys 
Agent Scripting automatically migrates the parameter definitions. It defines 
them with a direction of Input and a SQL Type of VARCHAR. This automatic 
migration might cause a discrepancy of types during runtime if the input 
parameter is not supposed to be of the type VARCHAR. Therefore, we recommend 
that you check all of the parameter definitions for all of the Database 
Interfaces. 

Special Considerations for Oracle Databases

Genesys Agent Scripting 7.2 and higher performs additional migration of all 
parameter definitions for the Oracle Database. In previous versions of Genesys 
Agent Scripting, a Stored Procedure Database Interface could only call Stored 
Procedures that contained output parameters that matched the columns defined 
in the Database Interface. The call to the Stored Procedure would result in data 
being returned in these columns. The columns are mapped to the Table Field 
defined in the Database Interface. The result was the return of one table row. 
This restricted the stored procedure from returning multiple rows for a table. 
This restriction was the result of the Oracle Database forcing all outputs from a 
stored procedure to be returned as output parameters, including SQL query 
results. 

Now, with the support of CURSOR output parameters, Genesys Agent Scripting is 
no longer forced to treat the defined columns as output parameters. The 
migration of Database Interfaces now results in defining new Output 
parameters of the type VARCHAR. This parameter applies to each of the defined 
columns whose output values are mapped to the Table Fields previously 
associated with the columns. 

The execution of the migrated Database Interface results in the associated 
fields being updated with the values from each output parameter. However, it 
does not force the defined Table Field associated with these fields to be 
updated. So, you must perform manual changes to force the Table Field to be 
reloaded. Or, you can change the Stored Procedure to remove the output 
parameter for each column, and to define an output parameter of the SQL Type 
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CURSOR. This will save the results of a SQL query into the Table Field defined 
for the Database Interface.
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Chapter

3 Installing Genesys Agent 
Scripting
This chapter describes how to install the Genesys Agent Scripting application.

This chapter contains the following sections:
 Installing Genesys Agent Scripting, page 25
 Deploying Genesys Agent Scripting with HTTPS Connection Support, 

page 27

Installing Genesys Agent Scripting
The Genesys Agent Scripting installation process uses an InstallShield Wizard. 
If you have a previously installed version of Genesys Agent Scripting on your 
computer, this version must be uninstalled before proceeding with the 
installation of the current version.

Your Existing Scripts Are Safe

You can relax: uninstalling Genesys Agent Scripting 7.2 will not destroy your 
business process scripts. They are preserved. As an added measure of safety, 
you may wish to copy some or all of those scripts to a different directory. Do 
your scripts have unique names? Backing up crucial data before a 
reconfiguration is always a good idea.

Genesys Agent Scripting also preserves the paths to your projects during the 
installation.

If you use Collaboration mode, refer to Chapter 6, “Using Genesys Agent 
Scripting in Collaboration Mode,” on page 53 for information about handling 
and converting project books.
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Procedure:
Install Genesys Agent Scripting

Start of procedure

1. Insert the CD into the CD drive.

The CD should begin the installation automatically. If it doesn’t start, go to 
the CD drive from Windows Explorer and double-click setup.exe.

The Checking Operating System Version screen displays a progress bar 
appears while the system prepares for installation. 

2. At the Welcome to the Installation of Genesys Agent Scripting screen, 
click Next to continue. 

3. At the Choose Destination Location screen, click the Default button to 
approve the default installation directory C:\Program Files\GCTI\Genesys 
Agent Scripting\ or click the Browse... button to select or create a new 
directory.

4. Click Next to continue with the installation.

The Ready to Install screen appears. The Wizard is ready to install the 
Genesys Agent Scripting application.

5. Click the Install button to start the installation process and to open the 
Installation Status screen.

This screen displays installation status. When the application has finished 
installing, the Installation Complete screen appears. 

6. Click Finish to close the wizard.

Genesys Agent Scripting is installed.

End of procedure.

Note: At any point in the install, you may quit by clicking Cancel or the 
X in the upper-right corner of any screen. At the Confirm Quit 
screen that appears, click Yes to confirm cancellation, or click No 
and then click Next to continue the installation.

Note: Genesys recommends using the default directory. Instructions later 
in the guide assume that Genesys Agent Scripting is installed in 
the default directory.
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Next Steps

• To run Genesys Agent Scripting, select Start > Programs > Genesys 
Solutions > Genesys Agent Scripting > Start Agent Scripting from the 
main taskbar.

• Genesys Agent Scripting contains a Help system that provides reference 
information on all the elements of the graphical user interface (GUI). Once 
you have started the Genesys Agent Scripting application, access the Help 
system in one of the following ways:
 Press F1.
 Select Help > Genesys Agent Scripting Help.

Help information is organized in a structure similar to the menu structure 
within Genesys Agent Scripting.

Deploying Genesys Agent Scripting with 
HTTPS Connection Support

Genesys Agent Scripting supports HTTPS for the connection between the 
Agent Desktop and the Genesys Agent Scripting web server. HTTPS is the 
communication protocol for secure encrypted communication. Security 
certificates are used to encrypt and ensure authenticity of communication 
during HTTPS connection. The client must trust the security certificated to 
allow secure communication with the website.

Configuring the HTTPS Connection for a Standalone Tomcat 
Setup (JSSE Implementation)

To generate a self-signed certificate with the Java tool, execute the following 
command and instructions:  
<JAVA_HOME>\bin\keytool -genkey -alias tomcat -keyalg RSA  -keystore 
<KEYSTORE_LOCATION>\keystore

Note: Use the Genesys Agent Scripting server fully qualified domain name 
as the Common Name when creating the certificate.
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Procedure:
Configure Tomcat for HTTPS Connection

Start of procedure

1. Configure Tomcat's connector in the <TOMCAT>/conf/server.xml file:
<Connector port="443" 
protocol="org.apache.coyote.http11.Http11Protocol"

   keystoreFile="<KEYSTORE_LOCATION>\keystore" 
keystorePass="<KEYSTORE_PASSWORD>"

   maxThreads="150" SSLEnabled="true" scheme="https" secure="true"

   clientAuth="false" sslProtocol="TLS" />

2. Configure the path to truststore in Java option (add the following line to 
top of  <TOMCAT>\bin\catalina.bat file):

set JAVA_OPTS=%JAVA_OPTS% 
-Djavax.net.ssl.trustStore="<KEYSTORE_LOCATION>\keystore" 

-Djavax.net.ssl.trustStorePassword="<KEYSTORE_PASSWORD>"

End of procedure

Configuring the HTTPS Connection for Apache with Tomcat 
Setup (OpenSSL Implementation)

The following example shows a self-signed certificate generated with the 
Apache openssl tool:
<APACHE>/bin/openssl req -x509 -nodes -days 365 -newkey rsa:2048 
-keyout "<APACHE>/conf/server.key" -out "<APACHE>/conf/server.crt" 
-config "<APACHE>/conf/openssl.cnf"

Procedure:
Configure Apache HTTPD for HTTPS Connection

Start of procedure

1. Uncomment the include conf/httpd-ssl.conf line in the 
<APACHE>/conf/httpd.conf file.

2. Modify the httpd-ssl.conf file:

a. Set the path to the certificate: SSLCertificateFile 
"<APACHE>/conf/server.crt"

Note: Use the Genesys Agent Scripting server fully qualified domain name 
as the Common Name when creating the certificate.
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b. Set the path to the key: SSLCertificateKeyFile 
"<APACHE>/conf/server.key"

3. Import the Apache HTTPD's certificate to JVM execute and follow the 
instruction:
"<JAVA_HOME>\bin\keytool" -import -alias apache_httpd -file 
"<APACHE>\conf\server.crt" -keystore 
"<JAVA_HOME>\jre\lib\security\cacerts"

End of procedure
 

Note:  When using the Tomcat node in a setup with Apache HTTPD , set the 
Target URL and the XMLServerURL to point into the Apache 
HTTPD HTTPS resource.
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Chapter

4 Installing Supporting 
Applications
This chapter describes how to install the supporting applications that Genesys 
Agent Scripting needs to run properly.

This chapter contains the following sections:
 Preparing to Install, page 31
 Database Drivers, page 31
 Installing Microsoft Visio 2003 Professional, page 33
 Preparing to Compile and Run Scripts: ASP, page 33
 Preparing to Compile and Run Scripts: JSP, page 34
 Installing Supporting Applications for JSP, page 35

Preparing to Install
Genesys Agent Scripting requires the presence of certain supporting 
applications to ensure smooth operation of all of its features and functions. The 
type of environment you will be using and the level of functionality you 
require from Genesys Agent Scripting determine which supporting 
applications you must install, as well as other configuration changes that may 
be required.

For system administrators wishing to use a Genesys Agent Scripting JSP 
Collaboration Server, additional software installations are required. See 
“Apache Tomcat or WebSphere Collaboration Server” on page 35 for details.

Database Drivers
You must install the corresponding database driver for your database platform.
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MS SQL 32 and 64 bit Databases

• Obtain the Java platform driver from this web page:
http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=11774

• Obtain the .NET platform driver by installing .NET framework 2.0, 3.0, 
3.5 or 4.0.

Oracle Databases

• Obtain the Java platforms 32 and 64 bit drivers from this web page: 
http://www.oracle.com/technetwork/database/features/jdbc/index-0912

64.html 
or find the driver in your database installation path, for example: 
path_to_oracle_DB\product\version_of_oracle\dbhome_1\jdbc\lib 

folder

• Obtain the .NET platform 32 bit driver from this web page:
http://www.oracle.com/technetwork/topics/dotnet/utilsoft-086879.html 

• Obtain the .NET platform 64 bit driver from this web page:
http://www.oracle.com/technetwork/database/windows/downloads/index-

090165.html 

MySQL Databases

• Obtain the MySQL on Java and .NET platforms drivers from this web 
page:
http://www.mysql.com/products/connector/ 

IBM DB2 Databases

• Obtain the Java platform driver from this web page:
http://www-01.ibm.com/support/docview.wss?uid=swg21363866 

• Obtain the .NET platform driver from this web page:
http://www-01.ibm.com/support/docview.wss?uid=swg21418043

JDBC Databases

• For the JDBC drivers, be certain that the corresponding *.jar file is in the 
TOMCAT_HOME/lib folder (the exact location depends on the installed 
Tomcat version), or any location that is accessible to the Java Web Server 
that is running the generated Agent Scripting Web application.
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Installing Microsoft Visio 2003 
Professional

Process flows and streams are two of the building blocks used to build business 
process scripts (Genesys Agent Scripting web applications) for end users. If 
agents intend to use process flow or stream diagrams to conceptualize and/or 
build process flows or streams, you must install Microsoft Visio 2003 
Professional on any system running Genesys Agent Scripting.

Genesys Agent Scripting looks for the presence of Microsoft Visio 2003 
Professional. If found, process flow and stream diagrams, as well as diagram- 
creation features, become available.

If Genesys Agent Scripting does not find Microsoft Visio 2003 Professional, 
the application functions normally, but without process flow and stream 
diagramming. 

Obtain Microsoft Visio 2003 Professional from any software retailer/vendor.

Preparing to Compile and Run Scripts: ASP
If you intend to build Genesys Agent Scripting web applications with Active 
Server Pages (ASPs), you will need access to a Microsoft IIS 6.0, 7.0 or 7.5 
web server to successfully compile, simulate, and run the script pages. 

• For Active Server Pages, you must have a Microsoft IIS 6.0, 7.0 or 7.5 web 
server on your system, or have network access to a server that is running 
Microsoft IIS 6.0, 7.0 or 7.5. 

• To deploy scripts, you will need remote access to the Microsoft IIS server 
that will host the scripts.

Building Business Process Scripts with Active Server 
Pages.NET (ASPXs)

If you intend to build Genesys Agent Scripting web applications with Active 
Server Pages.NET (ASPXs), you must have Microsoft.NET Framework 
Version 1.1 and the latest available Service Packs installed on your IIS server.

Notes: • Upon installation of (or upgrade to) the Microsoft Windows 2000 
Server operating system, Microsoft IIS 5.0 web server is installed 
automatically.

• Upon installation of (or upgrade to) the Microsoft Windows 2003 
Server operating system, Microsoft IIS 6.0 web server is installed 
automatically.
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• IIS 6.0—comes with Microsoft.NET Framework version 1.1 already 
installed.

When running Genesys Agent Scripting web applications as ASPs, the 
Microsoft XML Parser Version 3.0 or higher must be installed on the Server 
system for either of the following:

 IIS 6.0 - the appropriate version is already installed with the operating 
system.

Preparing to Compile and Run Scripts: JSP
If you intend to build Genesys Agent Scripting web applications with Java 
Server Pages (JSPs), you must install or have access to:

• The Java 2 Enterprise Edition (J2EE) SDK.

To successfully compile and run script pages, you need:

• An Apache Tomcat 5.0 or 6.0 web server, or WebSphere Application 
Server, Version 5.1 or 6.0.

J2EE SDK

The Java 2 Enterprise Edition SDK is required to enable Apache Tomcat 5.0 or 
6.0 to compile Java Server Pages (JSPs).

Obtain this SDK at no cost from Oracle’s Java website at 
http://www.oracle.com/technetwork/java/javaee/downloads/index.html.

Tomcat

The Java 2 Enterprise Edition v1.4.2 SDK or higher is required to enable 
Apache Tomcat 5.0 or 6.0 to compile Java Server Pages (JSPs). For Apache 
Tomcat 6.0, the Java 2 Enterprise Edition v5 SDK or higher is required.

Obtain this SDK at no cost from Oracle Java website at
http://www.oracle.com/technetwork/java/javaee/.

You will obtain a self-extracting archive with a name such as 
java_ee_sdk-6u3-windows.exe (the name of the file that you obtain may differ).

Microsoft IIS Collaboration Server

You do not need to install any additional software on your Microsoft Windows 
2000 or 2003 Server to build and use a Microsoft IIS Collaboration Server 
(ASP environment).

When running on Microsoft IIS, the Microsoft IIS 5.0 or 6.0 Collaboration 
Server database is set up automatically.

http://www.oracle.com/technetwork/java/javaee/
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When running business process scripts as ASPs, the Microsoft XML Parser 
Version 3.0 or higher must be installed on the Server system.

 IIS 5.0: available to download from Microsoft's website.
 IIS 6.0: the appropriate version is already installed with the operating 

system.

Apache Tomcat or WebSphere Collaboration Server

There are special requirements to build and use an Apache Tomcat or 
WebSphere web server as the Collaboration Server (JSP environment).

A MySQL database is required to run in Collaboration mode on a Tomcat 
server. This database server must be installed and started. Genesys Agent 
Scripting provides a SQL file to create the tables and fields that the 
Collaboration Server requires.

These steps must precede the conversion of a Project Book to Collaboration 
mode within Genesys Agent Scripting.

See “Installing MySQL for JSP Collaboration Mode” on page 37 for more 
details.

Installing Supporting Applications for JSP
For Java Server Pages, you will need to install either the Java 2 Enterprise 
Edition 1.4 SDK or 1.3.1. In addition, you must install the Apache Tomcat web 
server or the WebSphere 5.1 or 6.0 application server on your system or have 
network access to a server running an Apache Tomcat web server or a 
WebSphere 5.1 or 6.0 application web server.

Finally, if you will be using Collaboration mode for JSP, you must have a 
MySQL database available and you must install the open source MySQL 
Database Server on the computer running Genesys Agent Scripting.

Installing the Java 2 Enterprise Edition SDK

Download the Java 2 Enterprise Edition SDK from Sun’s Java website at 
http://www.oracle.com/technetwork/java/javaee/. You will obtain a 
self-extracting archive such as java_ee_sdk-6u3-windows.exe (the name of the 
file that you obtain may differ).

Note: To correctly set up with Tomcat in Collaboration mode under JSP, it is 
necessary to download the activation.jar and mail.jar files needed 
by Tomcat. They are not deployed by default. You can download 
these from http://java.sun.com/products/javamail/. Put them in 
...\common\lib directory under Tomcat.

http://www.oracle.com/technetwork/java/javaee/
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Double-click the self-extracting archive file and follow the instructions to 
install the SDK.

Installing Apache Tomcat

Download the Apache Tomcat 5.0 or 6.0 binary files at no cost from the 
Apache website at http://jakarta.apache.org/tomcat/. You will obtain a 
self-extracting archive such as jakarta-tomcat-5.5.29.exe (the name of the 
file you obtain may differ). 

Double-click the self-extracting archive file and follow the instructions to 
install Apache Tomcat.

Procedure:
Deploy Applications Under Tomcat

Purpose:  When using an Apache Tomcat web server, the generated Genesys 
Agent Scripting web application created by the Genesys Agent Scripting 
Development Environment is deployed as a separate application. During 
deployment, context information (folder WEB-INF) is automatically included, 
enabling Tomcat to recognize the application. If the generated Genesys Agent 
Scripting web application is deployed in the webapps folder of Tomcat, then 
Tomcat must be restarted to make the application available. 

If you are using Tomcat and you are not deploying the generated Genesys 
Agent Scripting web application in the Tomcat’s webapps folder, then you 
need to use Tomcat Web Application Manager to tell Tomcat where the 
application is deployed.

Start of procedure

1. Open a Web browser.

2. Go to http://<machine_name>:8080/manager/html (<machine_name> is the 
name of the machine on which Tomcat is installed). 

3. In the Tomcat Web Application Manager, specify the sub-directory folder 
of the generated Web application you wish to deploy.

End of procedure

Note: Install the Java 2 Enterprise Edition 1.4.2, 1.5, or v6 SDK before 
installing Tomcat. The Apache Tomcat installation looks for an 
installed Java Development Kit.
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Procedure:
Improving Genesys Agent Scripting Web Application 
Performance

Purpose:  To improve the performance of Genesys Agent Scripting web 
applications, set Tomcat's Maximum Memory Pool value to 1024 MB.

Start of procedure

1. Run: <Tomcat Installation Directory>/bin/TomcatW.exe.

2. Click the Java Properties tab.

3. Set Maximum Memory Pool to 1024 MB.

End of procedure

Installing IBM WebSphere 5.1 or 6.0 Application Server

Install WebSphere Application Server as you would any other Windows-based 
application. Follow the instructions throughout the installation process.

Install Java 2 EE 1.4.2 or 1.5 or v6 SDK following Oracle’s installation 
process.

Installing MySQL for JSP Collaboration Mode

Genesys Agent Scripting requires the presence of a MySQL database to 
convert a Project Book from single-user to multiple-user (Collaboration) mode 
within a JSP environment.

To use Collaboration mode for JSP, you must have a MySQL database 
available and you must install the open source MySQL Database Server on the 
computer that is running Genesys Agent Scripting.

For instructions on setting up a MySQL database, see “Creating and Setting 
Up a MySQL Database” on page 38.

Installing MySQL Database Server

Download the open source MySQL Database Server at no cost from 
http://www.mysql.com/downloads/index.html. You will obtain a ZIP file such 
as mysql-4.0.18-win.zip (the name of the file you obtain may differ).

Extract the installation files from the ZIP file, double-click setup.exe, and 
follow the instructions to install MySQL Database Server.

You now need to create a MySQL database if you intend to use the Genesys 
Agent Scripting Collaboration Module with JSP. See the next section for more 
details.
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Creating and Setting Up a MySQL Database

Procedure:
Create and Set up a MySQL Database

Prerequisites

• Install MySQL Database Server in the default directory: c:\mysql.

Start of procedure

1. Run MySQL Database Server from a command line.

2. Copy the SQL command file SQL_WWC_NEW_7-0-1.sql from the Genesys 
Agent Scripting JSP Collaboration folder (by default c:\Program 
Files\GCTI\Genesys Agent Scripting\Collaborate jsp Web Folder\) to 
the mysql\bin directory.

3. Access a command prompt in Windows:

a. Click the Start button.

b. Select Run.

c. Select or type cmd and click OK.

4. Change to the MySQL server directory: \mysql\bin.

5. Start the MySQL Database Server administrator tool if it is not already 
running: 
winmysqladmin

6. Log in as administrator:
mysql --user=root mysql

7. Create a user called wwc for Genesys Agent Scripting Collaboration:
GRANT ALL PRIVILEGES ON *.* TO ‘wwc’@‘hostname’ IDENTIFIED BY ‘wwc’ 
WITH GRANT OPTION;

hostname: This is the hostname from which the user 'wwc' will access the 
MySQL database. The hostname must be a fully qualified name, or can be 
set to % to indicate that the user can access this database from any host. 

8. Create a database called WWC to use for Genesys Agent Scripting 
Collaboration:
mysql> CREATE DATABASE WWC;

Note: You may substitute other values for the user (‘wwc’) and the 
password (‘wwc’). If you do, however, you will need to change the 
default values in the connection string file. See “Apache Tomcat 
or WebSphere Collaboration Server” on page 35.
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You may substitute another value for the database name (WWC). If you do, 
however, you will need to change the default value in the connection string 
file. See “Copy the Connection String File for the JSP Collaboration 
Server” on page 54.

9. Select this database (make it active):
mysql> USE WWC;

10. Invoke the SQL command file (SQL_WWC_NEW_7-0-1.sql) to create the tables 
needed for Genesys Agent Scripting Collaboration: 
mysql > SOURCE SQL_WWC_NEW_7-0-1.sql

11. Exit MySQL Administration:
mysql> EXIT

12. Close the Command Prompt window. 

The database is now set up properly.

End of procedure

Next Steps

• Install the MySQL Connector/J Driver (see below)

Procedure:
Install the MySQL Connector/J Driver

Prerequisites

• Apache Tomcat 5.0 or 6.0 must be installed in its default directory.

Start of procedure

1. Download the MySQL Connector/J Driver from 
http://www.mysql.com/downloads/index.html. (This is open-source 
software, available at no cost.) You will obtain a ZIP file whose name has 
the following form: 
mysql-connector-java-3.0.11-stable.zip

The name of the file you obtain may differ. Now install the downloaded 
file:

2. Extract the installation files from the ZIP file.

3. Locate the file mysql-connector-java-3.0.11-stable-bin.jar (the name of 
the .jar may differ), and copy it to the following location:

For Tomcat: <TOMCAT>\shared\lib



40 Genesys Agent Scripting 8.1

Chapter 4: Installing Supporting Applications Installing Supporting Applications for JSP

...where <TOMCAT> is the path to the Tomcat directory.

End of procedure

You have now installed all the supporting applications and drivers you need to 
run in Genesys Agent Scripting JSP Collaboration mode.

See Chapter 6, “Using Genesys Agent Scripting in Collaboration Mode,” on 
page 53 to continue the steps required to use Collaboration mode for JSP.

Upgrading a MySQL Database from Genesys Agent 
Scripting Version 7.0.0

If you are upgrading from Genesys Agent Scripting version 7.0.0 to version 
7.0.1 or higher, the MySQL Collaboration database must be upgraded. To do 
this, 

• Run the SQL command file SQL_WWC_UPDATE_7-0-1.sql against your 
current Genesys Agent Scripting 7.0.0 Collaboration database.

Note: No action is necessary when running on WebSphere Application 
Server version 5.1 or 6.0. 
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5 Installing Genesys Agent 
Scripting for Use with
Genesys Agent Interaction 
Layer
This chapter is intended for Genesys software administrators. It describes how 
to install Genesys Agent Scripting for use with the Genesys Agent Interaction 
layer, which is implemented in Java®.

Genesys Agent Scripting provides a Java Servlet that can be integrated with 
the Agent Desktop’s software to provide access to Genesys Agent Interaction 
Layer. Data from an interaction can be used to determine the server location 
and the starting point of the business process script to be used to process the 
interaction.

This chapter contains the following sections:
 Agent Desktop Integration with Genesys Agent Scripting, page 41
 Genesys Agent Scripting Server, page 50
 Genesys Agent Scripting Project Book, page 50
 T-Server Configuration, page 51

Agent Desktop Integration with Genesys 
Agent Scripting

Procedures in this section:
 Integrate Genesys Agent Desktop (v7.6 or higher) with Genesys Agent 

Scripting using Genesys Agent Interaction Layer, page 42
 Installing the Interaction Workspace Plug-in for Genesys Agent Scripting, 

page 44
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 Deploying Assignment Rules to Interaction Workspace, page 46
 Installing the Interaction Workspace plug-in for Genesys Agent Scripting, 

Simple Install Method, page 46
 Installing the Interaction Workspace plug-in for Genesys Agent Scripting, 

Click-Once Method, page 47

Procedure:
Integrate Genesys Agent Desktop (v7.6 or higher) with 
Genesys Agent Scripting using Genesys Agent 
Interaction Layer

Prerequisites

• These instructions assume that you have a basic Genesys Agent Desktop 
(GAD) installation. If the GAD has already been customized, these 
instructions must be modified accordingly.

• Genesys requires you to run the Genesys Agent Desktop on its own 
dedicated Java web server. Therefore the business process scripts should be 
deployed to a separate Java web server.

• For detailed information about the Genesys Agent Desktop application, 
refer to the Genesys Desktop 7.6 Deployment Guide and the Genesys 
Desktop 7.6 Developer's Guide.

Start of procedure

1. If Genesys Agent Desktop has NOT been previously customized:

a. Copy the entire directory from the GAS Install path 
...\GenesysIntegration\gdesktop\custom directly to the GAD Java 
Server's Web Application path ...\gdesktop\custom.

b. Copy the file custom.properties from the GAS Install path 
...\GenesysIntegration\gdesktop to the GAD Java Server's Web 
Application path ...\gdesktop\WEB-INF\classes. The string “Agent 
Scripting” may be changed to any value that you want to use as a label 
on the AgentScripting tab.

Note: If you are using the Genesys Agent Desktop (version 7.6 or higher), 
skip this section and proceed to the section entitled “Integrate Genesys 
Agent Desktop (v7.6 or higher) with Genesys Agent Scripting using 
Genesys Agent Interaction Layer” on page 42. 
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2. If Genesys Agent Desktop HAS been customized, you must update the 
customization files to include the Genesys Agent Scripting customization, 
as follows:

a. Modify ...\gdesktop\custom\custom.xml, which is located in the GAD 
Java Server's Web Application directory, to include the AgentScripting 
Tab information from the supplied sample AgentScripting.xml file 
from the ...\GenesysIntegration\gdesktop\custom directory.

b. Include the javascript-onload section for the GAD window in the 
custom.xml file.

c. Put AgentScripting.jsp in the GAD Java Server's Web Application 
directory ...\gdesktop\custom.   AgentScripting.jsp is located in the 
Genesys Agent Scripting Install directory 
...\GenesysIntegration\gdesktop\custom.

d. Add the following line 
AgentScripting=<Agent Scripting>

to this file

...\WEBINF\classes\custom.properties

where <Agent Scripting> is the name displayed on the AgentScripting 
tab.

3. Put the WWG.jar file in the ...\WEB-INF\lib directory. 

This file is in the Agent Scripting install directory: 
...\GenesysIntegration\lib\WWG.jar.

4. Update the web.xml file in the Java Server's Web Application directory 
...\gdesktop\WEB-INF to identify the Genesys Agent Scripting integration 
components. Code snippets are provided in web.xml.Sample in the Genesys 
Agent Scripting application Install directory ...\GenesysIntegration\.

a. Add the GASAssignerServlet definition.

b. Add the GASAssignerServlet mapping section.

c. Add the <init-param> for AgentScripting.xml to the <initUAD> 
servlet definition.

End of procedure

Note: Be aware of existing customFile<n> entries.
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Procedure:
Installing the Interaction Workspace Plug-in 
for Genesys Agent Scripting

Purpose:  To install the Interaction Workspace Plug-in for Genesys Agent 
Scripting on your web server, an agent workstation, or a development 
workstation. 

Prerequisites

• .NET Framework 3.5, SP 1 installed.

• Interaction Workspace 8.1.x installed, as described in the “Prerequisites” 
section in this procedure: Installing plug-ins for Interaction Workspace. 

Start of procedure

1. On your desktop, open the disc that contains the plug-in Installation 
Package (IP) and double-click the Setup.exe file.

The Genesys Installation Wizard launches and the Welcome panel is 
displayed. 

2. On the Welcome panel, do one of the following:
 Click Next to begin the installation procedure. 
 Click Cancel to exit the Genesys Installation Wizard. 
 Click About to open the plug-in ReadMe in your default browser. 

If you click Next, the wizard displays the Select Installed Application 
panel, which enables you to select the Interaction Workspace application 
instance to which you want to add the plug-in.

The Genesys Installation Wizard searches the target computer for an 
installed version of Interaction Workspace. Select the version of Interaction 
Workspace in the location in which you want plug-in to be installed.

The Application Properties pane displays the name, version, and location 
of the selected Interaction Workspace application. 

3. After you have selected the version of Interaction Workspace that you want 
to use with the plug-in, do one of the following: 
 Click Next to proceed to the next panel. 
 Click Cancel to exit the Genesys Installation Wizard. 
 Click Back to return to the previous panel. 

If you click Next, the Ready to Install panel is displayed. 

4. On the Ready to Install panel do one of the following: 
 Click Install to install the plug-in on your web server, development 

workstation, or agent workstation. 
 Click Back to return to the Select Installed Application panel. 

http://docs.genesys.com/Documentation/IW/8.1.4/Dep/InstallingPlug-insForInteractionWorkspace
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 Click Cancel to exit the Genesys Installation Wizard. 

If you click Next, the plug-in is installed in the location that you specified. 
When installation is complete, the Installation Complete panel is 
displayed. 

5. Click Finish to exit the Genesys Installation Wizard.

Plug-in files are copied into the target installation directory of the original 
Interaction Workspace deployment.

After the plug-in application is installed on the agent or developer 
workstation, or after it is downloaded by the ClickOnce application (see 
Deploying the ClickOnce Application on Your Web Server), and after the 
agent is granted permission to use the application, agents must login (to) 
Interaction Workspace on a Place that is associated with a SIP DN to use 
the plugin with Interaction Workspace. The plug-in process is started 
automatically when Interaction Workspace application is being initialized.

End of procedure

Next Steps

• Installation is complete. You can now provision the plugin functionality.

• Follow the steps in “Enable the Role Privilege”. 

Procedure:
Enable the Role Privilege

Purpose:  Make the Interaction Workspace -- Can Use Plugin for Agent 
Scripting role privilege available.

Prerequisites

• The Interaction Workspace application must be installed.

Start of procedure

1. Start Genesys Administrator.

2. Upload the Interaction Workspace plug-in for Genesys Agent Scripting:

a. Click the Upload Template button and browse to the /templates folder 
on the Genesys Agent Scripting installation CD.

b. Select the template named 
Interaction_Workspace_Plugin_For_Genesys_Agent_Scripting_810.apd

3. Under Environment > Application Templates, select Interaction 
Workspace.
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4. Click the Import Metadata button and select the file: 
Interaction_Workspace_Plugin_For_Genesys_Agent_Scripting_810.xml.

The Interaction Workspace - Can Use Plugin for Agent Scripting Role 
Privilege is now available. See Procedure: Creating a Role, allowing an 
Interaction Workspace privilege, and assigning a Role to an agent or agent 
group for information about managing the role privilege with Genesys 
Administrator

End of procedure

Procedure:
Deploying Assignment Rules to Interaction Workspace

Prerequisites

• Install and run Genesys Agent Scripting 8.1.

• Enable Mark Done support: 
Select the checkbox at the File > Settings / Advanced tab.

Start of procedure

1. Open the Process Flow Assignment Rules dialog box, and select the 
Deployment Settings tab.

2. Select the checkbox Deploy Rules for an Interaction Workspace.

3. Click the Deploy Rules button.

The deployment is completed. Interaction Workspace is ready to use the newly 
deployed Assignment Rules to assign the proper business process script.

End of procedure

Procedure:
Installing the Interaction Workspace plug-in for 
Genesys Agent Scripting, Simple Install Method

Prerequisites

• Install Interaction Workspace.

Note: To use Role-driven privileges, ensure that the security.disable-rbac 
option of your Interaction Workspace application is set to false. For 
more details about Roles usage, see Interaction Workspace Roles.

http://docs.genesys.com/Documentation/IW/8.1.4/Dep/RolePrivileges
http://docs.genesys.com/Documentation/IW/8.1.4/Dep/RolePrivileges
http://docs.genesys.com/Documentation/IW/8.1.4/Dep/RolePrivileges
http://docs.genesys.com/Documentation/ES/latest/SMSolution/IWPlugins
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Start of procedure

1. Install the Interaction Workspace plug-in for Genesys Agent Scripting 8.1 
into the same folder where you installed the Interaction Workspace 
application (InteractionWorkspace.exe).

See the generic procedure Installing Plug-ins for Interaction 
Workspace.

End of procedure

Next Steps

• The installation is completed. Run Interaction Workspace.

Procedure:
Installing the Interaction Workspace plug-in for 
Genesys Agent Scripting, Click-Once Method 

Prerequisites

• Install Interaction Workspace, selecting the Prepare a ClickOnce package 
option.

• Perform the procedure “Installing the Interaction Workspace plug-in for 
Genesys Agent Scripting, Simple Install Method” on page 46.

Start of procedure

1. Run the Interaction Workspace Deployment Manager.

2. Complete each of the following dialogs as they appear (see the Interaction 
Workspace Deployment Guide - Deployment Manager), then click Next.

Note: The default installation directory is <Program 
Files>\GCTI\Interaction—Workspace\, but please note that you can 
choose an option during the Interaction Workspace installation that 
puts InteractionWorkspace.exe into the similarly—but not 
identically—named folder <Program Files>\GCTI\Interaction 
Workspace\InteractionWorkspace.

In this case, you have to manually copy the Interaction Workspace 
Plug-In for Agent Scripting files 
(Genesyslab.Desktop.Modules.GASAssigner.deployment-config, 
Genesyslab.Desktop.Modules.GASAssigner.dll and 
Genesyslab.Desktop.Modules.GASAssigner.module-config) to the 
<Program Files>\GCTI\Interaction Workspace\InteractionWorkspace 

folder.

http://docs.genesys.com/Documentation/IW/8.1.4/Dep/InstallingPlug-insForInteractionWorkspace
http://docs.genesys.com/Documentation/IW/8.1.4/Dep/InstallingPlug-insForInteractionWorkspace
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3. At the Deployment Finished dialog, select the Show the Published Page 
checkbox and click Finish.

4. Install Interaction Workspace to the Agent workstation(s) from the web 
location (by default 
http://<click-once-server-name>/InteractionWorkspace/publish.htm)

End of procedure

Next Steps

• Localize the plug-in. See “Localizing the Interaction Workspace plug-in 
for Genesys Agent Scripting” on page 48.

• The installation is completed. Run Interaction Workspace at the Agent 
workstation:
Click or select: Start > All Programs > Genesys Telecommunications 
Laboratories > Interaction Workspace shortcut.

Localizing the Interaction Workspace plug-in for 
Genesys Agent Scripting

You can localize the plug-in that you just installed. In this case, localization 
means modifying the language of the label for the Agent Scripting view, and 
the language of the warning message concerning the Support Mark Done 
feature, which is described in Chapter 15: “Integrating with Genesys Software” 
in the Genesys Agent Scripting 8.1 User Guide. 

To localize, you create a new file that is specific to a language and country, 
found in the directory Program Files\GCTI\Interaction 
Workspace\Languages\, and named in the following format:

module_name.language_code-country_code.xml (for example: 
Genesyslab.Desktop.Modules.GASAssigner.en-US.xml for English as spoken in 
the United States).

The content of this file should have the same format and structure as the 
Genesyslab.Desktop.Modules.GASAssigner.en-US.xml file (in the same 
directory), with translated strings in the expected language.

The localization process is described fully in the Interaction Workspace wiki 
Custom Localization of Interaction Workspace, which offers specific 
instructions for localizing Interaction Workspace that apply equally to Genesys 
Agent Scripting. 

Note: This procedure localizes the plug-in only. You can of course create a 
business process script in any language that you can type.

http://docs.genesys.com/Documentation/IW#t-1
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Procedure:
Creating the Genesys Application for Genesys Agent 
Scripting

Purpose:  In order for Genesys Agent Scripting to access other Genesys 
components, you must set up an application for Genesys Agent Scripting in 
Genesys Configuration Manager. To do this, complete the following steps:

Start of procedure

1. In Configuration Manager, open the Environment folder, then the 
Application Templates folder. If Genesys_Agent_Scripting templates are 
absent, import them from the Template folder on the Genesys Agent 
Scripting CD at: //templates/Genesys_Agent_Scripting_810.apd

2. Create a new application from Configuration Manager using the 
Genesys_Agent_Scripting_810.apd template.

3. On the General tab, enter an Application Name. This name will be used by 
the GAS Server and should be supplied to the parameter 
G_Config_ApplName located in the Target Environment Properties dialog 
box, Configuration File tab.

4. In a multi-tenant environment, select the tenant tab and add the tenant with 
which this application will interact. Choose only one tenant.

5. On the Start Info tab enter a period “.” for the Working Directory and the 
Command line sections. This Start Info tab is not used.

6. On the Connections tab add a connection to the Premise T-Servers that 
your Agent Desktop application uses. Also, if your Agent Desktop 
application uses Contact Server, add this Contact Server.

7. On the Options tab fill in the license section with your appropriate 
information.

For more detailed information, refer to the Interaction SDK (Java) Deployment 
Guide.

End of procedure

Procedure:
Configuring Genesys Configuration Server for 
Outbound Operations

Purpose:  If you are using Outbound Contact Solution (requires version 
7.0.100.08 or higher) with Genesys Agent Scripting, then an additional section 
must be added to your Configuration Server's config file. 
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Start of procedure

1. Create a new section name: [soap].

2. In the newly-created section, create the following three options:
port =

debug =

client_lifespan =

3. Configure these options as appropriate for your environment.

For more information on these options, please refer to the Framework 8 
Configuration Options Reference Manual, Chapter 4, and particularly the 
section on SOAP.

End of procedure

Genesys Agent Scripting Server
When using deployed Agent Scripts integrated with Genesys Agent Interaction 
software, the Genesys Agent Interaction software Java files must be installed 
in a directory that is accessible by the Java Web Server. These files are shipped 
with Genesys Agent Scripting and are located in its installed path 
...\GenesysIntegration\lib.

For example, in Tomcat, you might put them in the ...\shared\lib directory.

Genesys Agent Scripting Project Book

Procedure:
Creating Agent Scripts that operate in the “Genesys 
Integrated” mode.

Purpose:  Genesys Agent Scripting provides built-in Agent Scripting objects 
that can be used by business process scripts to display Genesys information 
and perform actions on Genesys Interactions. 

Note: Restarting any web server—GAD or GAS Tomcats, GAS IIS, or 
Genesys Integration Server—requires that you also restart all 
Outbound campaigns.
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Start of procedure

1. When creating a new Project Book, select the base toolkit “Genesys Agent 
Interaction toolkit” from the Project Book Properties panel.

2. In Compile->Assignment Rules, on the Deployment Settings tab, set the 
“Genesys Agent Scripting Assigner Servlet URL” to the URL used to 
access the application hosting this servlet. 

This URL must end in the name of the servlet and match the appropriate 
mapping, which is specified in either “Agent Desktop Integration with 
Genesys Agent Scripting” in Step 3b, or “Integrate Genesys Agent 
Desktop (v7.6 or higher) with Genesys Agent Scripting using Genesys 
Agent Interaction Layer” in Step 4b. The default is GASAssigner. 

3. In Compile->Assignment Rules, set the Default URL to the deployed 
location of this Project Book.

4. Deploy the Assignment rules (even if empty, the Default URL must be set). 
Please note, the Agent Desktop Web Server needs to be running since the 
GAS Assigner Servlet from Step 2 will actually be invoked.

5. For each Target environment, the Configuration file parameters must be set 
(including the Configuration ManagerApplication name created from the 
procedure in the topic “Creating the Genesys Application for Genesys 
Agent Scripting” on page 49). 

End of procedure

T-Server Configuration

Procedure:
Verifying the correct T-Server configuration for 
interaction data transfer

Purpose:  GAS will attach interaction data to the call when a transfer with data 
is issued. In order for this data to be properly propagated to the new interaction 
an option in T-Server must be checked. 

Start of procedure

1. Open the T-Server application and go to the Options tab. 

2. Select the T-Server section and check the value of consult-user-data. 

3. This value must be inherited or joint for the GAS transfer to work properly. 



52 Genesys Agent Scripting 8.1

Chapter 5: Installing Genesys Agent Scripting for Use with Genesys Agent Interaction Layer T-Server Configuration

For more information on these options please consult your T-Server 
Deployment Guide.

End of procedure
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Chapter

6 Using Genesys Agent 
Scripting in Collaboration 
Mode
This chapter is intended for system administrators or business process script 
developers. It describes how to convert Genesys Agent Scripting Project 
Books for use in a multiple-user environment, and how to set up and manage 
users and Project Books in Collaboration mode.

This chapter contains the following sections:
 Preparing for the Conversion, page 53
 Converting a Project Book to Collaboration Mode, page 55
 Managing Users and Project Books, page 69
 Using Genesys Agent Scripting Collaboration Administration, page 76

Preparing for the Conversion
To use Genesys Agent Scripting in a multiple-user environment, databases - 
(called Project Books), must be converted to a format that allows for multiple 
users. Genesys refers to these converted Project Books as multiple-user or 
Collaboration mode Project Books.

You should have already completed the following:

1. Installed the Genesys Agent Scripting application.

2. Installed the appropriate supporting applications.

Note: Genesys Agent Scripting first opens with a Project Book called 
WWGDemo (file name WWGDemo.mdb), which is used throughout this 
chapter as an example to show how to back up a Project Book. 
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Prerequisites

• Backing Up Your Project Book—Before attempting to convert a Project 
Book to Collaboration mode, Genesys strongly recommends that you 
create a backup copy of the Project Book and store it in a safe location. 

This is recommended for two reasons:
 Converted Project Book files cannot be restored to Single-User mode.
 Should a Project Book file be damaged during or subsequent to 

conversion, your backup assures that the original file is intact.

Procedure:
Back Up a Project Book

Start of procedure

1. Locate the WWGDemo.mdb file in C:\Program Files\GCTI\Genesys Agent 
Scripting (assuming the default installation path).

2. Make a copy of this file and store it in the same folder.

End of procedure

Procedure:
Copy the Connection String File for the JSP 
Collaboration Server

Purpose:  The steps in this section apply only when you are setting up a JSP 
Collaboration Server.

Start of procedure

1. Navigate the following path:
C:\Program Files\GCTI\Genesys Agent Scripting\Collaborate jsp Web 
Folder

2. Select the file WWCConfigExample.inc.jsp and copy it.

3. Rename the copy to WWCConfig.inc.jsp.

Note: If you plan to convert additional Project Books to Collaboration 
mode: If the additional Project Books do not use the same 
Collaboration Server as your initial converted Project Book, do not 
carry out this procedure at this time! 
Instead, carry out this procedure before performing Step 8 in the 
section “Converting the Project Book” on page 57.
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4. Double-click WWCConfig.inc.jsp to open it.

Notepad opens with the file information shown in Figure 2 on page 55.

Figure 2: WWCConfig.inc.jsp file

5. If you set up the MySQL database and user information as described 
earlier, the information in this connection string should be correct 
(hostname = localhost, database = wwc, user = wwc, password = wwc).

6. If you created a different database, user, or password, then update the 
connection string with your values:
 /wwc? is replaced with /<your database name>?
 user=<your user name>
 password=<your password>

7. If you installed MySQL on a different machine, you need to change 
localhost to the machine name where the MySQL database resides.

8. If you make any changes to this file, select File > Save.

9. Exit from Notepad.

End of procedure

Converting a Project Book to 
Collaboration Mode

You are now ready to convert Project Books to Collaboration mode in the 
Genesys Agent Scripting Development Environment.

Creating a Folder for the Collaboration Server

You must create a folder for the Collaboration Server:
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• For a Microsoft IIS server (serving ASPs), create a WWC folder inside 
C:\Inetpub\wwwroot\.

• For an Apache Tomcat 5.0 or 6.0 server (serving JSPs), create a WWC folder 
inside:

For Tomcat: <TOMCAT>\webapps

...where <TOMCAT> is the path to the Tomcat directory.

The procedure above assumes that Apache Tomcat 5.0 or 6.0 was installed in 
its default directory.

The Collaboration Server folder is populated automatically during the Project 
Book conversion when you click the Test button on Step 8, page 60. Also, the 
WEB-INF folder will be deployed telling Tomcat that this is a runnable 
application. After the Collaboration Server folder has been populated, you 
must restart Tomcat to enable Tomcat to detect the application. 

Starting the Web Server

Before running Genesys Agent Scripting to convert Project Books to 
Collaboration mode, you should start the web server you will be using for 
collaboration as follows:

• For ASP, start the Microsoft IIS 5.0 or 6.0 web server.

• For JSP, start the Apache Tomcat 6.0, 7.0 or 7.5 web server, or WebSphere 
5.1 or 6.0.

• For JSP, when you are using WebSphere as a collaboration server. See 
“Using a WebSphere Application Server for the Collaboration Server” on 
page 64.

Starting Genesys Agent Scripting

Procedure:
Start Genesys Agent Scripting

Prerequisites

• Installed the supporting applications.

• Installed the Genesys Agent Scripting application.

• Created the Collaboration Server folder.

• For JSP, after you have created and set up a MySQL Database for running 
a JSP Collaboration Server.
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Start of procedure

1. Start Genesys Agent Scripting from the main taskbar by selecting Start > 
Programs > Genesys Solutions > Genesys Agent Scripting > Start Agent 
Scripting.

2. You may see a message to set up a path called 
C:\Inetpub\wwwroot\WWGDemo. This is for Microsoft IIS web servers and 
ASP. 
 If you will be using ASP, click Yes.
 If you will be using JSP, click No.

3. You may see an information box for Genesys Agent Scripting. Click Close 
(or wait for the box to close on its own).

When starting Genesys Agent Scripting for the first time, the WWGDemo Project 
Book opens by default and is displayed in the main window.

The WWGDemo Project Book (file name WWGDemo.mdb) is the file to use as an 
example for conversion.

End of procedure

Converting the Project Book

Procedure:
Convert a Project Book to Collaboration mode.

Again, the WWGDemo.mdb file is the example.

Note: If you have not backed up the WWGDemo.mdb file, see “Prerequisites” on 
page 54 and follow the instructions. Genesys strongly recommends 
that you back up any Project Book file that you intend to convert to 
Collaboration mode.

Note: You must convert a Project Book to Collaboration mode before any of 
the multiple-user options (such as Administrate or Lock/Unlock 
Database) become available.
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Start of procedure

1. From the Genesys Agent Scripting main menu, select File > Convert to 
Collaborate Mode.

This opens the first screen of the conversion wizard as shown in Figure 3. 
This first screen warns you to back up your Project Book file before 
carrying out the conversion.

Figure 3: Convert to Collaborate Wizard, Backup Warning

2. Click Next to proceed to the next screen of the wizard shown in Figure 4.

Figure 4: Convert to Collaborate Wizard, Find Server

3. Select asp or jsp as desired in the Server Language field.

4. Click Find Server to locate the server that will populate the Server 
Location field.
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The Select Target Directory for Collaborate Server dialog box opens 
as shown in Figure 5.

Figure 5: Convert to Collaborate Wizard, Navigate to WWC

5. In this dialog box, navigate to the folder you set up in “Creating a Folder 
for the Collaboration Server” on page 55 and click Open.

6. Click OK if you see a JSP Environment message.

The Server Location and Server URL fields are now populated in the 
conversion wizard as shown in Figure 6 on page 60.
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Figure 6: Convert to Collaborate Wizard, Fields Populated

7. Replace the host string in the Server URL field with the fully qualified host 
name and port used to access the Collaboration Server. This is the URL 
string that designers of this Project Book will use to address this 
Collaboration Server.

The default port for Apache Tomcat is 8080. The modified Server URL 
string is shown in Figure 6.

8. Click Test to test the connection to the Collaboration Server.

If successful, the screen shown in Figure 7 appears.

Note: Before proceeding to the next step, be sure to carry out the 
instructions detailed in “Copy the Connection String File for the 
JSP Collaboration Server” on page 54, if you have not already 
done so. The Test step will not work correctly unless you have 
copied (and updated) this connection string file.

Note: Clicking Test deploys the Collaboration Server, populating the WWC 
folder. For JSP, this includes the creation of a WEB-INF subfolder, 
which tells Tomcat that you have a runnable server. You must 
restart Tomcat to pick up this change.
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Figure 7: Convert to Collaborate Wizard, Server Installed/Connected

9. Click Next to proceed to the screen shown in Figure 8.

Figure 8: Convert to Collaborate Wizard, Provide Login Information

10. Enter admin in the UserID field.

11. Enter admin in the Password field.

12. Click Login.
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You are now logged in as shown in Figure 9.

Figure 9: Convert to Collaborate Wizard, Login Successful

13. Click Next to open the dialog box shown in Figure 10.

Figure 10: Convert to Collaborate Wizard, Start Conversion

14. Start the conversion of your Project Book to Collaboration mode by 
clicking Check In.

Warning! Depending on the size of the Project Book, this conversion 
process may require a lot of time. Once you start it, you cannot 
stop it without destroying the Project Book file.
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The conversion process proceeds as shown in Figure 11. Allow the 
conversion process to complete.

Figure 11: Convert to Collaborate Wizard, Converting Project Book

Figure 12: Convert to Collaborate Wizard - Conversion Complete

15. Click Finish when you see the screen shown in Figure 12.

End of procedure
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Using a WebSphere Application Server for the Collaboration 
Server

Procedure:
Use a WebSphere Application Server for the 
Collaboration Server

Purpose:  The Genesys Agent Scripting install directory contains a file called 
WWC.war. This file is suitable for deployment on the WebSphere Application 
Server. To use a WebSphere Application Server, follow these steps: 

Start of procedure

1. After WWC.war has been installed as a Web Application on the WebSphere 
Application Server, update the WWCConfig.inc.jsp file to use the 
appropriate configuration string for accessing the mySQL database (see 
Figure 2).

2. Update the XMLServer tag in the WWGConfig.xml file to contain the correct 
URL specification for the WebSphere Server (the default port number for 
WebSphere is 9080).

3. Once these changes are complete, start the Web Application using the 
WebSphere Administration utility.

End of procedure

Procedure:
Converting a Project Book to Collaboration Mode 
using WebSphere for the Collaboration Server

Purpose:  Carry out the following steps to convert a Project Book to 
Collaboration mode for WebSphere as the Collaboration Server. Again, the 
WWGDemo.mdb file is the example.

Note: You must convert a Project Book to Collaboration mode before any of 
the multiple-user options (such as Administrate or Lock/Unlock 
Database) become available.
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Start of procedure

1. From the Genesys Agent Scripting main menu, select File > Convert to 
Collaborate Mode.

This opens the first screen of the conversion wizard as shown in Figure 13. 
This first screen warns you to back up your Project Book file before 
carrying out the conversion.

Figure 13: Convert to Collaborate Wizard, Backup Warning

2. Click Next to proceed to the next screen of the wizard shown in Figure 14.

Figure 14: Convert to Collaborate Wizard, Find Server

3. Select jsp in the Server Language field.
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Figure 15: Convert to Collaborate Wizard, Fields Populated: WebSphere

4. Replace the host string in the Server URL field with the fully qualified host 
name and port used to access the Collaboration Server. This is the URL 
string that designers of this Project Book will use to address this 
Collaboration Server.

The default port for WebSphere Application Server is 9080. The modified 
Server URL string is shown in Figure 15.

5. Click Test to test the connection to the Collaboration Server.

If successful, the screen shown in Figure 16 appears.

Figure 16: Convert to Collaborate Wizard, Server Installed/Connected
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6. Click Next to proceed to the screen shown in Figure 17.

Figure 17: Convert to Collaborate Wizard, Provide Login Information

7. Enter admin in the UserID field.

8. Enter admin in the Password field.

9. Click Login.

You are now logged in as shown in Figure 18.

Figure 18: Convert to Collaborate Wizard, Login Successful

10. Click Next to open the dialog box shown in Figure 19.
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Figure 19: Convert to Collaborate Wizard, Start Conversion

11. Start the conversion of your Project Book to Collaboration mode by 
clicking Check In.

The conversion process proceeds as shown in Figure 20. Allow the 
conversion process to complete.

Figure 20: Convert to Collaborate Wizard, Converting Project Book

Warning! Depending on the size of the Project Book, this conversion 
process may require a lot of time. Once you start it, you cannot 
stop it without destroying the Project Book file.
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Figure 21: Convert to Collaborate Wizard - Conversion Complete

12. Click Finish when you see the screen shown in Figure 21.

End of procedure

Managing Users and Project Books
Once you have converted a Project Book to Collaboration mode, you can 
access the tools that enable you to manage users and Project Books.

For example, the File menu changes when you are in multiple-user 
(Collaboration) mode, as shown in Figure 22.

Figure 22: File Menu for Collaboration Mode

The Collaborate option on the File menu opens a submenu with several 
options. The following subsections provide descriptions of the options. Also, 
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note that the File menu items called Lock Exclusive and Unlock Exclusive are 
available only in a multiple-user environment.

Lock Exclusive/Unlock Exclusive

In Collaboration mode, you can lock the Project Book for your exclusive use, 
and release the lock after you have made changes and checked in all objects.

Lock Exclusive

The Lock Exclusive feature enables you to lock the Project Book for your 
exclusive use. Lock Exclusive appears in the File menu only when Genesys 
Agent Scripting is in Collaboration mode. 

In this operational mode, you do not need to check out individual records to 
make changes. However, you must check in all changes prior to releasing the 
exclusive lock. If a Project Book is locked exclusively, another user cannot 
modify any objects until the exclusive lock is released. 

When you select File > Lock Exclusive, the dialog box shown in Figure 23 
opens (Database means Project Book).

Figure 23: Lock Exclusive

Click OK to confirm the message. The current Project Book is now locked for 
your exclusive use.

Unlock Exclusive

If you have been working with an exclusively locked Project Book, you can 
use the Unlock Exclusive option to release the exclusive lock. 

• When a Project Book is locked, the Unlock Exclusive option appears in the 
File menu, replacing the Lock Exclusive option that appears when you are 
in Collaboration mode. You can use this option to release the exclusive 
lock. 

• Before releasing the lock, you must check in all objects as described in 
“Check In” on page 72. 
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• When you select File > Unlock Exclusive, the dialog box shown in 
Figure 24 opens (database means Project Book).

Figure 24: Unlock Exclusive

• Click OK to confirm the message. If you have checked in all objects, the 
current Project Book is now unlocked and available to other users.
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Check In

The Check In option checks in changes that you or another user has made to 
objects, updating the collaboration database and making the objects available 
for other users to modify. When you select this option, the dialog box shown in 
Figure 25 opens.

Figure 25: Collaboration Check In

The Object column in this dialog box lists all objects in the Project Book that 
are currently checked out. Other columns provide the name of each object that 
has been checked out, a description of the object, and the date the object was 
checked out.

• To select an object for check in, select the box to the left of the object 
under the Object column.

• Before checking in changes to the Admin database, you must provide a 
comment describing the changes that you have made.

• Click Check In to check in the selected objects. Once objects are checked 
in, other users can view the changes.
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Check Out

Use the Check Out option to lock Project Book objects so they can be safely 
updated without affecting the work of other users. When you select this option, 
the dialog box shown in Figure 26 opens.

Figure 26: Collaboration Check Out

• Use the Show Objects of Type drop-down list to filter the Object list to 
only show objects of a certain type. Valid types are [ALL], Projects, 
Process Flows, Streams, Pages, Fields, Actions, Database Interfaces, 

XML Interfaces, Functions, and API Interface.

Note: By default, objects are automatically checked out when you edit them. 
However, you can turn off this automatic check out by going to File > 
Settings > Collaborate tab and deselecting the box labelled 
Automatically Lock Pages When the User Clicks on the Page in the 

Script View. 

This is useful when you are simply looking at a Project Book and 
don’t want to be required to check in all the Process Flows/Streams 
and pages just because you looked at them. 

However, if you attempt to edit a page which is not checked out, you 
will get a warning dialog box, This page cannot be edited at this 
time. You will need to check out the page before editing it.
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• The Object column lists all objects in the Project Book that are currently 
not checked out. Objects are described under the Description column. To 
check out an object, select the check box next to it.

• Click Check Out to check out the selected objects. Until an object is 
checked back in, other users cannot modify or delete it.

• The Progress pane at the bottom of the Collaboration Check Out dialog 
box shows the progress as each object is checked out. 

Apply Updates

The Apply Updates option applies all changes checked in by other users to the 
local copy of the Project Book.

• When you select File > Collaborate > Apply Updates, the dialog box 
shown in Figure 27 opens (Build database means Rebuild Project Book).

Figure 27: Apply Updates

• Click Apply Updates to rebuild the local Project Book with all changes that 
you have checked in.

Build Project Book

The option to build a Project Book builds a new copy of a Collaboration 
Server-controlled, Genesys Agent Scripting Project Book. You will need to 
build a copy of the Project Book for each user of the project and they will be 
required to log onto the server before doing any editing with that Project Book. 

Note: Objects are automatically checked out when you edit them from any 
Genesys Agent Scripting dialog box.

Note: Before checking out an object, Genesys Agent Scripting automatically 
updates the local copy.
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While users will have their own Project Books, all changes are stored in the 
common Collaboration Server. 

• When you select File > Collaborate > Build Project Book, the dialog 
box shown in Figure 28 opens. (Note that Build database means Build 
Project Book).

Figure 28: Build Project Book

• Click Setup New Database to create a new copy of the Project Book.

Scan for Errors

Genesys Agent Scripting Project Books can run in either of two modes:

• Pessimistic mode

• Optimistic mode

In Pessimistic mode, the Project Book assumes that users are going to do 
things that conflict with each other, so the Project Book prevents this from 
happening. For example, this mode prevents a user from adding a new 
reference to an object that a different user is currently attempting to delete.

In Optimistic mode, the Project Book assumes that users are not going to do 
things that conflict with each other. It operates as if these situations are very 
rare and not worth the cycle time. 

Use the Scan for Errors option to scan the Project Book for any errors that 
may occur when the Project Book is running in Optimistic mode.

Note: The assigned Admin user should not be a business process script 
editor. This Admin user is responsible for maintaining users and 
building Collaboration mode Project Books.

Warning! Make sure that you regularly back up your Project Book files to a 
secure location. If you do not make backup copies of your Project 
Book files, you will not be able to recover any lost information.
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• When you select File > Collaborate > Scan for Errors, the dialog box 
shown in Figure 29 opens.

Figure 29: Scan for Errors

• Click Scan to check for errors in the Project Book.

Administrate

Use this option to launch Genesys Agent Scripting Collaboration 
Administration, which is described in detail in the next section.

Using Genesys Agent Scripting 
Collaboration Administration

As a system administrator or business process script developer in a 
multiple-user Genesys Agent Scripting environment, you can set up, update, 
and manage users and Project Books.
◆ Select File > Collaborate > Administrate to run Collaboration 

Administration.

Note: You must be running in Collaboration mode in order to access 
Collaboration Administration.
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Login Screen

The Login screen as shown in Figure 30 opens in a web browser when you 
launch Collaboration Administration.

Figure 30: Collaboration Administration Login Screen

The first time you open Collaboration Administration, the UserID and Password 
are both set to admin. You can change these values later when you update user 
information. See “Updating Users” on page 82. 

For now: Enter admin in the UserID field, enter admin in the Password field, and 
click Login.

The Home screen opens in the web browser as shown in Figure 31 on page 78.

Home Screen

Figure 31 on page 78 shows the Collaboration Administration Home Screen. 
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Figure 31: Collaboration Administration Home Screen

Genesys Agent Scripting 7 Collaboration Administration has two main 
functions:

• User maintenance

• Project Book maintenance

You will click Update Users or Update Servers (Update Servers means Update 
Project Books) from the Home screen’s left panel depending on which type of 
maintenance function you wish to run.
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Setting Up and Managing Users (Update Users)

This section describes how to set up and manage Genesys Agent Scripting 
users who will be sharing Project Books that are converted to Collaboration 
mode.

The user maintenance function enables you to add new users or to modify and 
deactivate existing ones.

Click Update Users on the left panel to open the screen shown in Figure 32 in a 
web browser.

Figure 32: Update Users
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Procedure:
Adding Users

Purpose:  The Insert User function enables an Admin user to add new users to 
the Admin database.

Start of procedure

1. Click Insert User to open the screen shown in Figure 33 in the web 
browser:

Figure 33: Insert User
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2. Enter a value in the UserID field.

This is the UserID to log into Genesys Agent Scripting in Collaboration 
mode, or into Genesys Agent Scripting Collaboration Administration. You 
can enter up to 100 characters in this field. The value you enter must be 
unique.

3. Enter the user’s name in the User Name field.

You can enter up to 200 characters in this field.

4. Enter a password for this user in the Password field.

This is the password to log into Genesys Agent Scripting in Collaboration 
mode, or into Genesys Agent Scripting Collaboration Administration. You 
can enter up to 100 characters in this field. Any text you enter will be 
hidden.

5. If you want this user to have access to Genesys Agent Scripting 
Collaboration Administration, select the Admin User check box.

If the check box is not selected, this user can run Genesys Agent Scripting 
in Collaboration mode, but will be unable to access Collaboration 
Administration.

6. Click Insert User to add the new user to the Genesys Agent Scripting 
Admin database.

Your new user is added to the list of user records in the User Table. In the 
example shown in Figure 34 on page 82, UserID = 2004, User Name= Sal 
Thomas, and the user is active but is not an Admin user.
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Figure 34: New User Added

End of procedure

Procedure:
Updating Users

Purpose:  The User Table shown in Figure 34 lists all user accounts. Use the 
radio button next to each user to select a specific user account to update, 
delete, or activate.
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Start of procedure

1. Click Show All Users to display all active and inactive user accounts.

Inactive user accounts are accounts that were deactivated or deleted. They 
are maintained in the Admin database, but the user is unable to log in. See 
Figure 35.

Figure 35: Show All Users

2. Select the radio button beside a user record in the User Table that you want 
to update.
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When you do this, the user record fields on the screen are populated with 
the user’s information, as shown in Figure 36 on page 84.

Figure 36: Update User Information

3. Change any information that you want to update about this user.
 To change the UserID, User Name, or Password: edit the appropriate 

field.
 To give this user administration rights: select the Admin User check 

box.
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 To remove administration rights: clear the Admin User check box.

4. Complete your update by doing one of the following:
 Click Update User to register the changes you made into the Admin 

database.
 Click Delete User to deactivate this user account. The user record 

remains in the Admin database, but the user is unable to log in unless 
reactivated.

 Click Activate User to activate or reactivate a user account that is 
currently inactive. In the example shown in Figure 36 on page 84, 
clicking Activate User adds a check mark to the Active User check 
box and allows this user to regain login rights.

End of procedure

Setting Up and Managing Project Books (Update Servers)

This section describes how to manage Genesys Agent Scripting Project Books 
that users will share.

Admin users can lock and unlock Project Books using the Project Book 
maintenance portion of Genesys Agent Scripting Collaboration 
Administration.

• Click Update Servers in the left panel to open the screen shown in 
Figure 37 on page 86 in a web browser.
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Figure 37: Update Servers (Project Books)

As you can see in Figure 37, the Server Table contains a list of Project Book 
files that have been converted to Collaboration mode; the column Database 
Name contains the list of Project Book files. The following characteristics of the 
Project Book are provided in the table:

• Project Book file name

• Lock mode (Pessimistic or Optimistic)

• Whether the Project Book is currently locked

• Whether the Project Book has an exclusive lock (achieved by selecting 
File > Lock Exclusive as described earlier)

• If locked, the user name of the user who has locked the Project Book

Procedure:
Changing the Lock Mode

The Project Book can be locked in one of two ways:

In Pessimistic mode, the Project Book assumes that users are going to do 
things that conflict with each other, so the Project Book prevents this from 
happening. 
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For example, this mode prevents a user from adding a new reference to an 
object that a different user is currently attempting to delete.

In Optimistic mode, the Project Book assumes that conflict situations are very 
rare and not worth the cycle time.

Start of procedure

1. Select the radio button beside the Project Book file in the Server Table 
whose properties you want to modify.

2. Click Change Lock Mode.

You must check in all objects before you can change the lock mode. If you 
have objects that are checked out, check them in as described in “Check 
In” on page 72. If other users have checked out objects, these users must 
also check in their items before you can change the lock mode.

Once all items have been checked in, Change Lock Mode will change the Project 
Book from Pessimistic mode to Optimistic mode, or vice versa.

End of procedure

Procedure:
Unlocking the Project Book

Selecting the Locked? check box for a Project Book record in the Server Table 
places a database-wide lock on that Project Book.

As system administrator or business process script developer with Admin 
rights, you can clear this check box. If the Project Book also has an exclusive 
lock placed on it, you must release the exclusive lock before you can unlock 
the Project Book. Exclusive- lock maintenance is handled from within the 
Genesys Agent Scripting application.

Start of procedure

1. Select the radio button beside the Project Book file in the Server Table 
whose properties you want to modify.

2. Click Unlock Database to clear the database-wide lock on the currently 
selected Project Book.

End of procedure

Note: You cannot change the lock mode if the Project Book is currently 
locked or if it has an exclusive lock. You must unlock the Project 
Book or release the exclusive lock (select File > Unlock Exclusive) 
before you can change the lock mode.
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Why Unlock a Project Book?

When Genesys Agent Scripting is in the process of checking in or checking out 
components, it places a lock on the entire Project Book so that no one else can 
make changes to the project book during its operation. Under normal 
conditions, this lock is acquired and released automatically. However, if a 
user’s machine crashes or the network goes down during the course of a check 
in or check out, this global lock might not be released. In these instances, use 
Collaboration Administration to manually clear this lock.

Exclusive Lock

Selecting the Locked Exclusive? check box for a Project Book record in the 
Server Table locks a Project Book for a user’s exclusive use. In this mode, the 
user does not have to check out individual records to make changes. However, 
the user must check in all changes before releasing the exclusive lock.

Notes: • You should only clear a lock manually if it is apparent that the last 
check in or check out failed and is no longer processing.

• Only Project Book-level locks are displayed in the Server Table. 
You must administer more specific locks, such as locks on 
individual Scripts, Pages, Fields, and so on, through the Genesys 
Agent Scripting application.
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Chapter

7 Load Balancing and 
Failover
This chapter describes the Genesys Agent Scripting load balancing and 
failover feature.

Genesys Agent Scripting is able to benefit from load balancing by efficient 
agent distribution among available service nodes. In a Load Balancing 
configuration, the Failover feature covers automatic switching to a working 
service node on node failure.

This chapter contains the following sections:
 Load Balancing, page 89
 Architecture, page 90
 Configuration, page 92
 Failover, page 100
 Advanced Tunning, page 101

Load Balancing
The Genesys Agent Scripting load balancing feature is supported for 
Interaction Workspace client intergation for Tomcat deployments only. The 
Apache HTTP Server is configured to use the mod_jk or mod_proxy module for 
load balancing. These modules perform load balancing to distribute workload 
between Genesys Agent Scripting servers. Genesys Agent Scripting load 
balancing implies session affinity, also known as “sticky” sessions. 

Session affinity means that as long as the load balancer started a session at a 
specific node, all requests are sent back to that same node until the session 
ends. On node failure, the session is reinitialized on the available node. 
Unsaved session data is lost during the failover switch.
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Architecture
This section describes the architecture for single and multiple Apache server 
configurations.

Single Apache Server Load Balancing

The Interaction Workspace plug-in sends information to the Apache HTTP 
Server which in turn distributes the work load over APJ13 protocol using the 
mod_proxy or the mod_jk Apache modules on several Genesys Agent Scripting 
Servers. Figure 38 illustrates this architecture.

Figure 38: Single Apache Server Load Balancing Architecture

Multiple Apache Server Load Balancing

The Interaction Workspace plug-in sends information to the Apache HTTP 
TOP Server which in turn distributes the work load over HTTP protocol using 
the mod_proxy Apache module on several Genesys Agent Scripting Servers. 
Figure 39 illustrates this architecture.
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Figure 39: Multiple Apache Server Load Balancing Architecture
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Configuration
This section describes how to configure the Apache HTTP Server for load 
balancing.

Configuring Load Balancing for a Single Apache HTTP Server

The following procedures describe how to configure load balancing on a single 
server.

Procedure:
Prepare the Genesys Agent Scripting Tomcat Server

Purpose:  To configure the Tomcat server for Apache load balancing.

Start of procedure

1. Edit the <path to tomcat>\conf\server.xml file, and add the jvmRoute 
attribute to the Server/Service/service node—for example, <Engine 
name="Catalina" defaultHost="TomcatServer1" 

jvmRoute="jvmRouteValueN">.

2. In the <path to tomcat>\conf\server.xml file, enable the AJP1.3 
connector by uncommenting the following line:

<Connector port="ajpPort1" protocol="AJP/1.3" 
redirectPort="xxxxx" />

End of procedure

Procedure:
Configure the Apache HTTP Server using the 
mod_proxy module

Purpose:  To configure a single Apache HTTP Server using the mod_proxy 
module for load balancing.

Start of procedure

1. n the <path to Apache>\conf\httpd.conf file, enable (uncomment) the 

Note: The value of the jvmRoute attribute must be the same value as the 
value in the workers.properties file (see Step 2 on page 94).



Deployment Guide 93

Chapter 7: Load Balancing and Failover Configuration

following lines:
LoadModule proxy_module modules/mod_proxy.so

LoadModule proxy_ajp_module modules/mod_proxy_ajp.so

LoadModule proxy_balancer_module modules/mod_proxy_balancer.so

2. In the <path to Apache>\conf\mod_proxy.conf file, add the the following 
definitions (according to your environment):
ProxyPass /gas balancer://gas-cluster              

stickysession=JSESSIONID|jsessionid  nofailover=On

ProxyPassReverse /gas balancer://gas-cluster   
stickysession=JSESSIONID|jsessionid  

<Proxy /gas >

    Order deny,allow

    Allow from all

</Proxy>

<Proxy balancer://gas-cluster >

   BalancerMember ajp://tomcat1.host:28009/gas route=worker1

   BalancerMember ajp://tomcat2.host:38009/gas route=worker2

</Proxy>

#Failover

ErrorDocument 500  /error.node.html?script1=gas

ErrorDocument 501  /error.node.html?script1=gas

ErrorDocument 502  /error.node.html?script1=gas

ErrorDocument 503  /error.node.html?script1=gas

ErrorDocument 504  /error.node.html?script1=gas

ErrorDocument 505  /error.node.html?script1=gas

3. Copy the <Genesys Agent Scripting Install Directory>\error.node.html 
file to the <path to Apache>\DocumentRoot\ directory.

Procedure:
Configure the Apache HTTP Server using the mod_jk 
module

Purpose:  To configure a single Apache HTTP Server using the mod_jk module 
to achieve maximum load balancing.

Note: Ports 28009 and 38009 are ajp ports. Worker1 and worker2 are the 
jvmroute values of the corresponding Tomcat nodes.
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Start of procedure

1. In the <path to Apache>\conf\httpd.conf file, add the following 
definitions (according to your environment):
<IfModule !mod_jk.c>

   LoadModule jk_module modules/mod_jk.so

</IfModule>

JkWorkersFile conf/workers.properties

JkMount  /gas* router

#Failover

ErrorDocument 500  /error.node.html?script1=gas

ErrorDocument 501  /error.node.html?script1=gas

ErrorDocument 502  /error.node.html?script1=gas

ErrorDocument 503  /error.node.html?script1=gas

ErrorDocument 504  /error.node.html?script1=gas

ErrorDocument 505  /error.node.html?script1=gas

2. Create the <path to Apache>\conf\workers.properties file, and enter the 
following:
worker.list=router

worker.router.type=lb

worker.router.balance_workers=worker1, worker2, worker3

worker.router.sticky_session=True

worker.router.sticky_session_force=True

worker.worker1.type=ajp13

worker.worker1.host=tomcat1.host

worker.worker1.port=28009

worker.worker2.type=ajp13

worker.worker2.host=tomcat2.host

worker.worker2.port=38009

worker.worker3.type=ajp13

worker.worker3.host=tomcat3.host

worker.worker3.port=48009

Note: Ports 28009, 38009,and 48009 are ajp ports of the corresponding 
Tomcat nodes.
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3. Copy the <Genesys Agent Scripting Install Directory>\error.node.html 
file to the <path to Apache>\DocumentRoot\ directory

End of procedure

Procedure:
Deploy multiple project books using the mod_proxy 
module

Purpose:  To configure each proxy server for deployments with several project 
books.

Start of procedure

1. In the <path to Apache>\conf\httpd.conf file, enable (uncomment) the 
following lines:

LoadModule proxy_module modules/mod_jk.so

2. In the <path to Apache>\conf\mod_proxy file, enter the following for each 
project book:
# gas1 

ProxyPass /gas1 balancer://gas1-cluster              
stickysession=JSESSIONID|jsessionid  nofailover=On

ProxyPassReverse /gas1 balancer://gas1-cluster   
stickysession=JSESSIONID|jsessionid  

<Proxy /gas1 >

    Order deny,allow

    Allow from all

</Proxy>

<Proxy balancer://gas1-cluster >

   BalancerMember ajp://tomcat1.host:28009/gas1 route=worker1

   BalancerMember ajp://tomcat2.host:38009/gas1 route=worker2

</Proxy>

# gas2 

ProxyPass /gas2 balancer://gas2-cluster              
stickysession=JSESSIONID|jsessionid  nofailover=On

ProxyPassReverse /gas2 balancer://gas2-cluster   
stickysession=JSESSIONID|jsessionid  

<Proxy /gas2 >

    Order deny,allow
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    Allow from all

</Proxy>

<Proxy balancer://gas2-cluster >

   BalancerMember ajp://tomcat1.host:28009/gas2 route=worker1

   BalancerMember ajp://tomcat2.host:38009/gas2 route=worker2

</Proxy>

#Failover

ErrorDocument 500  /error.node.html?script1=gas1&script2=gas2

ErrorDocument 501  /error.node.html?script1=gas1&script2=gas2

ErrorDocument 502  /error.node.html?script1=gas1&script2=gas2

ErrorDocument 503  /error.node.html?script1=gas1&script2=gas2

ErrorDocument 504  /error.node.html?script1=gas1&script2=gas2

ErrorDocument 505  /error.node.html?script1=gas1&script2=gas2

3. Copy the <Genesys Agent Scripting Install Directory>\error.node.html 
file to the <path to Apache>\DocumentRoot\ directory.

End of procedure

Procedure:
Compile and assign the Genesys Agent Scripting 
Script

Start of procedure

1. Create a separate Target Environment item for each Genesys Agent 
Scripting server. Use the Genesys Agent Scripting server URL as the 
Target URL, and as the value for the XMLServerURL attribute on the 
Configuration File tab.

2. Compile the script for each Genesys Agent Scripting server separately.

Note: Ports 28009, and 38009 are ajp ports. Worker1 and worker2 are the 
jvmroute values of the corresponding Tomcat nodes.

Note: Some options of the ProxyPass directive contradicts Genesys 
Agent Scripting load balancing which prevents proper 
functioning. For example, the lbmethod (not mentioned in this 
chapter) has a default value of byrequests. It is recommended not 
to change this default value.
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3. Create a Target Environment item for the Apache HTTP Server. Use the 
Apache Server URL as the Target URL. Use this target during the 
deployment of Assignment rules in the Genesys Studio Main Menu > 
Compile > Assignment Rules > Deployment Settings > Environment list 
box.

End of procedure

Configuring Load Balancing for Multiple Apache Servers

The following procedures describe how to configure load balancing on 
multiple Apache Servers.

Note: Before using, Tomcat compiles the JSP pages into servlets 
automatically with the first page request. Because this task can 
take some time, Genesys recommends pre-compiling the JSP 
pages using the Genesys Agent Scripting Studio Main Menu > 
Compile > Compile > Try to pre-compile jsp pages option.

Note: Each Genesys Agent Scripting node must have a unique 
application name in Configuration Manager.

Note: Multiple Apache configuration is supported with the mod_proxy 
module only.
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Procedure:
Configure the Apache server

Purpose:  To configure load balancing for multiple Apache HTTP Servers.

Prerequisites

• Configure the Genesys Agent Scripting Tomcat servers (see Procedure: 
Prepare the Genesys Agent Scripting Tomcat Server, on page 92).

Start of procedure

1. Configure the Apache HTTP Servers, see “Configure the Apache HTTP 
Server using the mod_proxy module” on page 92, Steps 1 to 2. 

2. Edit the <path to Apache>\conf\httpd.conf file, and specify additional 
port listeners that are used to configure the Apache HTTP TOP server:
Listen portWorker1

Listen portWorker2

Listen portWorkerN

End of procedure

Procedure:
Configure the Apache HTTP TOP Server using the 
mod_proxy module

Purpose:  To configure the Apache HTTP TOP server.

Start of procedure

1. Edit the <path to Apache>\conf\httpd.conf file and enable (uncomment) 
the following lines:
LoadModule proxy_module modules/mod_proxy.so

LoadModule proxy_ajp_module modules/mod_proxy_ajp.so

LoadModule proxy_balancer_module modules/mod_proxy_balancer.so

LoadModule proxy_http_module modules/mod_proxy_http.so

Note: The total number of port listeners should not be less than the 
number of Tomcat servers.
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2. Edit the <path to Apache>\conf\mod_proxy.conf file, and add the 
following:
ProxyPass /gas balancer://gas-cluster              
stickysession=JSESSIONID|jsessionid  nofailover=On

ProxyPassReverse /gas balancer://gas-cluster   
stickysession=JSESSIONID|jsessionid  

<Proxy /gas >

    Order deny,allow

    Allow from all

</Proxy>

<Proxy balancer://gas-cluster >

  BalancerMember http://apache.node1.host:8380/gas route=worker1

  BalancerMember http://apache.node1.host:8381/gas route=worker2

  BalancerMember http://apache.node2.host:8480/gas route=worker3

  BalancerMember http://apache.node2.host:8481/gas route=worker4

</Proxy>

#Failover

ErrorDocument 500  /error.node.html?script1=gas

ErrorDocument 501  /error.node.html?script1=gas

ErrorDocument 502  /error.node.html?script1=gas

ErrorDocument 503  /error.node.html?script1=gas

ErrorDocument 504  /error.node.html?script1=gas

ErrorDocument 505  /error.node.html?script1=gas

3. Copy the <Genesys Agent Scripting Install Directory>\error.node.html 
file to the <path to Apache>\DocumentRoot\ directory

End of procedure

Note: Ports 8380, 8381, 8480, and 8481 are the ports of corresponding the 
Apache HTTP server nodes. worker1, worker2, worker3, and 
worker4 are the jvmroute values of the corresponding Tomcat 
nodes.
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Procedure:
Compile and assign the Genesys Agent Scripting 
Script

Start of procedure

1. Compile the Genesys Agent Scripting script, see “Compile and assign the 
Genesys Agent Scripting Script” on page 96, Steps 1 and 2.

2. Create a Target Environment item for the Apache HTTP Server. Use the 
Apache HTTP TOP Server URL as the Target URL. Use this target during 
the deployment of Assignment rules in the Genesys Studio Main Menu > 
Compile > Assignment Rules > Deployment Settings > Environment list 
box.

.

End of procedure

Configuring the Genesys Agent Scripting Studio

To increase the speed of Genesys Agent Scripting page delivery, early jsp file 
pre-complication is available.

Procedure:
Enable Faster Runtime Execution

1. Launch the Genesys Agent Scripting Studio.

2. Select Compile.

3. Under Options, select Try to pre-compile jsp pages.

End of procedure

Failover
Failover is supported by using multiple Apache configuration and Tomcat node 
failover. Failover configuration is covered by Load Balancing configuration as 
described in the “Configuration” on page 92 section. 

The following options in the Apache module configuration are required for

Note: Each Genesys Agent Scripting node must have a unique 
application name in Configuration Manager.
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failover support (which allows the client to re initiate session):

• nofailover=On (for the mod_proxy method)

• worker.router.sticky_session_force=True (for the mod_jk method)

Server error handling is done by by pathing through error.node.html 
according to following defenitions in the httpd.conf file:
#Failover

ErrorDocument 500  /error.node.html?script1=gas

ErrorDocument 501  /error.node.html?script1=gas

ErrorDocument 502  /error.node.html?script1=gas

ErrorDocument 503  /error.node.html?script1=gas

ErrorDocument 504  /error.node.html?script1=gas

ErrorDocument 505  /error.node.html?script1=gas

Advanced Tunning
This section provides advanced tuning examples.

Configuring Apache Capacity

Edit the Apache HTTP Server configuration file httpd.conf, which is located 
in the <path to apache>/conf/ subdirectory.

Modify the following values:

For Windows: <IfModule mpm_winnt.c>
ThreadLimit 5000 (can be set up to 15000)
ThreadsPerChild 5000 (can be set up to ThreadLimit)
MaxRequestsPerChild 0
</IfModule>

For Linux: <IfModule prefork.c>
ServerLimit 5000 (can be set up to 20000)
MaxClients 5000 (can be set up to ServerLimit)
MaxRequestsPerChild 0

</IfModule>
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Genesys Integration with 
the ASPX Platform
Genesys Agent Scripting 8.1 supports Genesys integration with the ASPX 
platform. You can create an ASPX target environment for a Project Book with 
the Genesys Agent Interaction Toolkit. 

Please note these requirements:

• To work within the Genesys environment, ASPX business process scripts 
created with the Genesys Agent Interaction Toolkit require Genesys 
Integration Server version 7.2 or later.

• For release 7.2, new configuration fields for ASPX target environments 
were added:
 G_NETServer_PrimaryHost
 G_NETServer_PrimaryPort
 G_NETServer_BackupHost
 G_NETServer_BackupPort

To compile a Project Book for the ASPX target environment, you must 
populate these fields with the appropriate information about Genesys 
Integration Server, which is used by ASPX business process scripts. 

These fields appear on the Configuration File tab. To access them, choose 
Target Environment from the Compile menu, then select (or create) an 
ASPX target environment, and click on the Configuration File tab.

For detailed information about Genesys Integration Server, refer to the 
Genesys Integration Server Deployment Guide.
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Supplements

Related Documentation 
Resources
The following resources provide additional information that is relevant to this 
software. Consult these additional resources as necessary.

Genesys Agent Scripting

• Genesys Agent Scripting 8.1 Help, which explains how to use Genesys 
Agent Scripting and its associated components. 

• Genesys Agent Scripting 8.1 User Guide, which explains how to use 
Genesys Agent Scripting and its associated components.

• Release Notes and Product Advisories for this product, which are available 
on the Genesys Technical Support website at 
http://genesys.com/customer-care.

Genesys Agent Desktop

• Genesys Agent Desktop 7.6 Deployment Guide, which explains how to 
install and configure Genesys Agent Desktop and its associated 
components.

Interaction Workspace

• Interaction Workspace 8.1 Deployment Guide, an online wiki that explains 
how to install and configure Interaction Workspace and its associated 
components.

Genesys

• Genesys Glossary provides a comprehensive list of the Genesys and 
computer-telephony integration (CTI) terminology and acronyms used in 
this documentGenesys Migration Guide, which ships on the Genesys 

http://docs.genesys.com/Glossary
http://genesys.com/customer-care
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Documentation Library DVD, provides documented migration strategies 
for Genesys product releases. Contact Genesys Technical Support for more 
information.

Information about supported hardware and third-party software is available on 
the Genesys Documentation website in the following documents: 

• Genesys Supported Operating Environment Reference Guide
• Genesys Supported Media Interfaces Reference Manual
Consult the following additional resources as necessary:

• Genesys Hardware Sizing Guide, which provides information about 
Genesys hardware sizing guidelines for the Genesys 8.x releases.

• Genesys Interoperability Guide, which provides information on the 
compatibility of Genesys products with various Configuration Layer 
Environments; Interoperability of Reporting Templates and Solutions; and 
Gplus Adapters Interoperability.

• Genesys Licensing Guide, which introduces you to the concepts, 
terminology, and procedures that are relevant to the Genesys licensing 
system.

For additional system-wide planning tools and information, see the 
release-specific listings of System Level Documents on the Genesys 
Documentation website. 

Genesys product documentation is available on the:

• Genesys Technical Support website at http://genesys.com/customer-care.

• Genesys Documentation website at http://docs.genesys.com/.

• Genesys Documentation Library DVD which you can order by e-mail from 
Genesys Order Management at orderman@genesys.com.

http://genesys.com/customer-care
mailto:orderman@genesys.com
http://docs.genesys.com/
http://docs.genesys.com/MoreDocs/Genesys_Supported_Operating_Environment_Reference_Guide
http://docs.genesys.com/MoreDocs/Genesys_Supported_Operating_Environment_Reference_Guide
http://docs.genesys.com/Special:Repository/g_ref_smi.pdf?id=73c96eb2-c7cb-4839-95e5-0c910861e615
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Document Conventions
This document uses certain stylistic and typographical 
conventions—introduced here—that serve as shorthands for particular kinds of 
information.

Document Version Number

A version number appears at the bottom of the inside front cover of this 
document. Version numbers change as new information is added to this 
document. Here is a sample version number:

80fr_ref_06-2008_v8.0.001.00 

You will need this number when you are talking with Genesys Technical 
Support about this product.

Screen Captures Used in This Document

Screen captures from the product graphical user interface (GUI), as used in this 
document, may sometimes contain minor spelling, capitalization, or 
grammatical errors. The text accompanying and explaining the screen captures 
corrects such errors except when such a correction would prevent you from 
installing, configuring, or successfully using the product. For example, if the 
name of an option contains a usage error, the name would be presented exactly 
as it appears in the product GUI; the error would not be corrected in any 
accompanying text.

Type Styles

Table 1 describes and illustrates the type conventions that are used in this 
document.
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Table 1: Type Styles

Type Style Used For Examples

Italic • Document titles

• Emphasis

• Definitions of (or first references to) 
unfamiliar terms

• Mathematical variables

Also used to indicate placeholder text within 
code samples or commands, in the special case 
where angle brackets are a required part of the 
syntax (see the note about angle brackets on 
page 108).

Please consult the Genesys Migration 
Guide for more information.

Do not use this value for this option.

A customary and usual practice is one 
that is widely accepted and used within a 
particular industry or profession.

The formula, x +1 = 7 
where x stands for . . .

Monospace 
font

(Looks like 
teletype or 
typewriter 
text)

All programming identifiers and GUI 
elements. This convention includes:

• The names of directories, files, folders, 
configuration objects, paths, scripts, dialog 
boxes, options, fields, text and list boxes, 
operational modes, all buttons (including 
radio buttons), check boxes, commands, 
tabs, CTI events, and error messages.

• The values of options.

• Logical arguments and command syntax.

• Code samples.

Also used for any text that users must 
manually enter during a configuration or 
installation procedure, or on a command line.

Select the Show variables on screen 
check box.

In the Operand text box, enter your 
formula.

Click OK to exit the Properties dialog 
box.

T-Server distributes the error messages in 
EventError events.

If you select true for the 
inbound-bsns-calls option, all 
established inbound calls on a local agent 
are considered business calls.

Enter exit on the command line.

Square 
brackets ([ ])

A particular parameter or value that is optional 
within a logical argument, a command, or 
some programming syntax. That is, the 
presence of the parameter or value is not 
required to resolve the argument, command, or 
block of code. The user decides whether to 
include this optional information.

smcp_server -host [/flags]

Angle 
brackets 
(< >)

A placeholder for a value that the user must 
specify. This might be a DN or a port number 
specific to your enterprise.

Note: In some cases, angle brackets are 
required characters in code syntax (for 
example, in XML schemas). In these cases, 
italic text is used for placeholder values.

smcp_server -host <confighost>
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